HEC-GridUtil
Grid Utility Program
Managing Gridded Data with HEC-DSS

User's Manual

Version 2.0
September 2011
**HEC-GridUtil**

Todd E. Steissberg, CEIWR-HEC-WMS
Matthew M. McPherson, CEIWR-HEC-WRS

US Army Corps of Engineers
Institute for Water Resources
Hydrologic Engineering Center (HEC)
609 Second Street
Davis, CA  95616-4687

Approved for public release; distribution is unlimited.

The Hydrologic Engineering Center's utility program for managing gridded time-series data, HEC-GridUtil, was developed to facilitate viewing of and to perform basic utility functions on gridded data sets in HEC-DSS (Hydrologic Engineering Center’s Data Storage System).

**HEC-GridUtil, HEC-DSS, HEC-DSSVue, HEC-HMS, CWMS, USACE, US Army Corps of Engineers, Hydrologic Engineering Center, HEC, gridded data, spatial data, raster data, grids, grid cells, time series, viewing, visualize, animate, extract, mosaic, mathematical operations, values, units, coordinates, time interval, hydrology, water resources studies, precipitation, meteorology, environment, HRAP, SHG, XMRG, NetCDF, NWS, RFC, NEXRAD, storage, software, computer program, graphical user interface, GUI, Java**
Grid Utility Program, HEC-GridUtil User’s Manual

2011. This Hydrologic Engineering Center (HEC) documentation was developed with U.S. Federal Government resources and is therefore in the public domain. It may be used, copied, distributed, or redistributed freely. However, it is requested that HEC be given appropriate acknowledgment in any subsequent use of this work.

Use of the software described by this document is controlled by certain terms and conditions. The user must acknowledge and agree to be bound by the terms and conditions of usage before the software can be installed or used. For reference, a copy of the terms and conditions of usage are included in Appendix J so that they may be examined before obtaining the software. The software described by this document can be downloaded for free from our internet site (www.hec.usace.army.mil).

HEC cannot provide technical support for this software to non-Corps users. Non-Corps individuals should use any internet search engine to locate a vendor that can provide support for the HEC software of interest. However, we will respond to all documented instances of program errors. Documented errors are bugs in the software due to programming mistakes, not model problems due to user-entered data.

This document contains references to product names that are trademarks or registered trademarks of their respective owners. Use of specific product names does not imply official or unofficial endorsement. Product names are used solely for the purpose of identifying products available in the public market place.

Microsoft and Windows are registered trademarks of Microsoft Corp.
Solaris and Java are trademarks of Sun Microsystems, Inc.
ArcGIS, ArcView, and ArcInfo are trademarks of ESRI, Inc.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table of Contents</td>
<td>i</td>
</tr>
<tr>
<td>List of Figures</td>
<td>v</td>
</tr>
<tr>
<td>List of Tables</td>
<td>vii</td>
</tr>
<tr>
<td>Acknowledgments</td>
<td>ix</td>
</tr>
<tr>
<td>Foreword</td>
<td>xi</td>
</tr>
<tr>
<td><strong>Chapters</strong></td>
<td></td>
</tr>
<tr>
<td>1 Introduction</td>
<td></td>
</tr>
<tr>
<td>1.1 Purpose</td>
<td>1-1</td>
</tr>
<tr>
<td>1.2 DSS Concepts</td>
<td>1-1</td>
</tr>
<tr>
<td>1.3 Characteristics and Capabilities of GridUtil</td>
<td>1-2</td>
</tr>
<tr>
<td>1.4 Gridded Data Formats and Conversions</td>
<td>1-4</td>
</tr>
<tr>
<td>1.5 Documentation Conventions</td>
<td>1-4</td>
</tr>
<tr>
<td>2 Requirements and Setup</td>
<td></td>
</tr>
<tr>
<td>2.1 Hardware and Software Requirements</td>
<td>2-1</td>
</tr>
<tr>
<td>2.2 Installation Procedure</td>
<td>2-1</td>
</tr>
<tr>
<td>2.3 Uninstall Procedure</td>
<td>2-3</td>
</tr>
<tr>
<td>3 Using HEC-GridUtil: An Overview</td>
<td></td>
</tr>
<tr>
<td>3.1 HEC-GridUtil Main Window</td>
<td>3-1</td>
</tr>
<tr>
<td>3.2 Menu Bar</td>
<td>3-2</td>
</tr>
<tr>
<td>3.3 Map Tools</td>
<td>3-6</td>
</tr>
<tr>
<td>3.4 Time Window</td>
<td>3-7</td>
</tr>
<tr>
<td>3.5 Cumulative Display</td>
<td>3-7</td>
</tr>
<tr>
<td>4 Getting Started</td>
<td></td>
</tr>
<tr>
<td>4.1 Creating a New Watershed</td>
<td>4-1</td>
</tr>
<tr>
<td>4.2 Coordinate System Setup</td>
<td>4-2</td>
</tr>
<tr>
<td>4.3 Automatic Setting of Map Extents</td>
<td>4-4</td>
</tr>
<tr>
<td>5 Using Layers</td>
<td></td>
</tr>
<tr>
<td>5.1 Concept of Layers</td>
<td>5-1</td>
</tr>
<tr>
<td>5.2 Map Layers</td>
<td>5-1</td>
</tr>
<tr>
<td>5.2.1 Map Layer Formats</td>
<td>5-1</td>
</tr>
<tr>
<td>5.2.2 Adding Map Layers</td>
<td>5-3</td>
</tr>
<tr>
<td>5.2.3 Removing Map Layers</td>
<td>5-5</td>
</tr>
<tr>
<td>5.2.4 Map Layer Operations</td>
<td>5-5</td>
</tr>
<tr>
<td>5.2.5 Geographic Reference for Map Layers</td>
<td>5-6</td>
</tr>
<tr>
<td>5.3 Layer Visualization Scaling</td>
<td>5-8</td>
</tr>
<tr>
<td>5.3.1 Setting Visualization Scales – Vector Layers</td>
<td>5-8</td>
</tr>
<tr>
<td>5.3.2 Setting Visualization Scales – Raster Images</td>
<td>5-9</td>
</tr>
</tbody>
</table>
# Table of Contents (continued)

## Chapters

### 6 Single Grid Data
- 6.1 Single Grid Menu ................................................................. 6-1
- 6.2 Creating a New Single Grid ................................................... 6-1
- 6.3 Displaying a Single Grid ......................................................... 6-3
- 6.4 Displaying Cell Values ........................................................... 6-7
- 6.5 Importing Single Grid Data ..................................................... 6-8
  - 6.5.1 XMRG Grids ................................................................. 6-8
  - 6.5.2 ASCII Grids ................................................................. 6-8
- 6.6 Exporting Single Grid Data .................................................... 6-9
  - 6.6.1 ArcInfo ASCII Grid ....................................................... 6-9
  - 6.6.2 ASCII Dump ................................................................. 6-9

### 7 Grid Sets
- 7.1 Grid Set Menu .................................................................. 7-1
- 7.2 Creating a Grid Set ............................................................... 7-1
- 7.3 Displaying a Grid Set ........................................................... 7-3
- 7.4 Exporting and Importing Grid Sets ......................................... 7-5
  - 7.4.1 Export a Grid Set ......................................................... 7-5
  - 7.4.2 Import a Grid Set .......................................................... 7-7

### 8 Data Analysis
- 8.1 Time Series Functions ......................................................... 8-1
- 8.2 Mean Areal Value ............................................................... 8-4

### 9 Data Management
- 9.1 Data Mosaic .................................................................. 9-1
- 9.2 Extract Region .................................................................. 9-2

## Appendices

### A References ................................................................. A-1

### B Grids in DSS
- B.1 Identifying Grid Records in DSS ........................................... B-1
- B.2 Contents of a Grid Record in DSS ......................................... B-2
- B.3 Storage of Grid Values ......................................................... B-2
- B.4 Grid Header Contents ......................................................... B-3

### C HRAP Grid System
- C.1 Examples ................................................................ C-1

### D SHG Grid System
- D.1 Examples ................................................................ D-2
# Table of Contents (continued)

## Appendices

### E Setting Up the Coordinate System
- E.1 Geographic Referencing ................................................................. E-1
- E.2 Coordinate System Types ............................................................... E-2
  - E.2.1 X-Y Coordinate System .......................................................... E-3
  - E.2.2 Geographic Coordinate System .............................................. E-4
  - E.2.3 Universal Transverse Mercator Coordinate System .............. E-4
  - E.2.4 State Plane Coordinate System .............................................. E-5
  - E.2.5 Albers Equal-Area Conic Coordinate System ....................... E-6
  - E.2.6 Lambert Conformal Conic Coordinate System ...................... E-7
  - E.2.7 Transverse Mercator Coordinate System .............................. E-8
  - E.2.8 Albers Equal-Area Conic (SHG) Coordinate System ............. E-9
  - E.2.9 Polar Stereographic (HRAP) Coordinate System .................. E-10

### F Using Map Editors
- F.1 Arc Shapefiles (.shp) ................................................................. F-1
- F.2 USGS Digital Line Graph (.dlg) .................................................. F-7
- F.3 Elevation Options Dialog Box .................................................... F-8

### G Using the Color Chooser
- G.1 Swatches Tab ................................................................................ G-1
- G.2 HSB Tab ....................................................................................... G-2
- G.3 RGB Tab ...................................................................................... G-3

### H Importing Gridded Data into DSS
- H.1 ascii2dssGrid ................................................................................. H-1
  - H.1.1 Program Use .......................................................................... H-2
  - H.1.2 Program Parameters .............................................................. H-2
- H.2 gridLoadXMRG ............................................................................. H-2
  - H.2.1 Program Use .......................................................................... H-3
  - H.2.2 Program Parameters .............................................................. H-4
  - H.2.3 Extracting Data ...................................................................... H-5
- H.3 gridLoadNetCDF ........................................................................... H-6
  - H.3.1 Program Use .......................................................................... H-6
  - H.3.2 Program Parameters .............................................................. H-6
- H.4 grib2xmrG .................................................................................. H-7
  - H.4.1 Program Use .......................................................................... H-7

### I Exporting Gridded Data from DSS
- I.1 dss2asciiGrid ................................................................................ I-1
  - I.1.1 Program Use .......................................................................... I-1
  - I.1.2 Program Parameters .............................................................. I-2

### J Terms and Conditions for Use ......................................................... J-1
# List of Figures

<table>
<thead>
<tr>
<th>Figure Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-1</td>
<td>Terms and Conditions for Use Dialog Box</td>
</tr>
<tr>
<td>3-1</td>
<td>HEC-GridUtil Main Window</td>
</tr>
<tr>
<td>3-2</td>
<td>Menu Bar</td>
</tr>
<tr>
<td>3-3</td>
<td>Time Window Dialog Box</td>
</tr>
<tr>
<td>4-1</td>
<td>Create New Watershed Dialog Box</td>
</tr>
<tr>
<td>4-2</td>
<td>Select Watershed Folder Browser</td>
</tr>
<tr>
<td>4-3</td>
<td>Watershed Summary Dialog Box</td>
</tr>
<tr>
<td>4-4</td>
<td>Layer Selector</td>
</tr>
<tr>
<td>4-5</td>
<td>Display Coordinate Information Dialog Box</td>
</tr>
<tr>
<td>4-6</td>
<td>Map Coordinate Information Dialog Box</td>
</tr>
<tr>
<td>4-7</td>
<td>Display Coordinate Information Dialog Box</td>
</tr>
<tr>
<td>5-1</td>
<td>GridUtil’s Image Metadata File</td>
</tr>
<tr>
<td>5-2</td>
<td>Open File Browser – Select Map to Add</td>
</tr>
<tr>
<td>5-3</td>
<td>Display Coordinate Information Dialog Box</td>
</tr>
<tr>
<td>5-4</td>
<td>Map Coordinate Information Dialog Box</td>
</tr>
<tr>
<td>5-5</td>
<td>Image Properties Dialog Box – Scale Tab</td>
</tr>
<tr>
<td>6-1</td>
<td>Create a New Single Grid Dialog Box</td>
</tr>
<tr>
<td>6-2</td>
<td>Set Configuration Dialog Box</td>
</tr>
<tr>
<td>6-3</td>
<td>Grided Data Configuration Panel</td>
</tr>
<tr>
<td>6-4</td>
<td>Layer Selector</td>
</tr>
<tr>
<td>6-5</td>
<td>Display Coordinate Information Dialog Box, X-Y coordinates</td>
</tr>
<tr>
<td>6-6</td>
<td>Display Coordinate Information Dialog Box, State Plane Coordinates</td>
</tr>
<tr>
<td>6-7</td>
<td>Color Scales Window</td>
</tr>
<tr>
<td>6-8</td>
<td>GridUtil Main Window with Display Options Dialog Box</td>
</tr>
<tr>
<td>6-9</td>
<td>Grid Display Options Dialog Box</td>
</tr>
<tr>
<td>6-10</td>
<td>Display Cell Value</td>
</tr>
<tr>
<td>6-11</td>
<td>Display Multiple Cell Values</td>
</tr>
<tr>
<td>6-12</td>
<td>Single Grid Menu – Importing</td>
</tr>
<tr>
<td>7-1</td>
<td>Time Window Dialog Box</td>
</tr>
<tr>
<td>7-2</td>
<td>Create a New Grid Set Dialog Box</td>
</tr>
<tr>
<td>7-3</td>
<td>Grid Set Selection Dialog Box</td>
</tr>
<tr>
<td>7-4</td>
<td>Color Scales Window</td>
</tr>
<tr>
<td>7-5</td>
<td>Grid Display Options Dialog Box</td>
</tr>
<tr>
<td>7-6</td>
<td>GridUtil Time Series Panel</td>
</tr>
<tr>
<td>7-7</td>
<td>Export Grid Set Dialog Box</td>
</tr>
<tr>
<td>7-8</td>
<td>Import Grid Set Dialog Box</td>
</tr>
<tr>
<td>8-1</td>
<td>Create Single Grid of Daily Accumulated Precipitation</td>
</tr>
<tr>
<td>8-2</td>
<td>Create Grid Set of Daily Mean Precipitation</td>
</tr>
<tr>
<td>8-3</td>
<td>Create Grid Set of Daily Maximum Precipitation</td>
</tr>
<tr>
<td>8-4</td>
<td>Grid Parameters File</td>
</tr>
<tr>
<td>8-5</td>
<td>Mean Areal Value Dialog Box</td>
</tr>
<tr>
<td>9-1</td>
<td>Data Mosaic Tool</td>
</tr>
<tr>
<td>9-2</td>
<td>Mosaic of Two Grid Sets</td>
</tr>
<tr>
<td>9-3</td>
<td>Extract Selection</td>
</tr>
</tbody>
</table>
9-4 Extract Region Dialog Box ................................................................. 9-4
9-5 Extracted Region in Map Panel ............................................................ 9-5
B-1 One-Dimensional Array Storing Two-Dimensional Data Grid ............ B-3
C-1 HRAP Grid ......................................................................................... C-1
D-1 SHG Grid .......................................................................................... D-1
E-1 Display Coordinate Information Dialog Box ........................................ E-1
E-2 Map Coordinate Information Dialog Box ............................................ E-2
E-3 Geographic Coordinate System .......................................................... E-3
E-4 Universal Transverse Mercator Coordinate System ............................. E-5
E-5 State Plane Coordinate System ............................................................ E-5
E-6 Albers Equal-Area Conic Coordinate System ........................................ E-6
E-7 Lambert Conformal Conic Coordinate System ....................................... E-7
E-8 Transverse Mercator Coordinate System ............................................. E-7
E-9 Albers Equal-Area Conic (SHG) Coordinate System ............................. E-9
E-10 Polar Stereographic (HRAP) Coordinate System ................................. E-10
F-1 Edit Line Properties Dialog Box with One Style selected .................... F-1
F-2 Edit Line Properties Dialog Box with Attribute Values selected ........... F-2
F-3 Editing a stream layer according to stream lengths ............................. F-3
F-4 Inclusion of labels indicating stream lengths ........................................ F-3
F-5 Edit Polygon Properties Dialog Box .................................................... F-4
F-6 Polygon fill edited according to elevation ............................................. F-4
F-7 Polygon Borders ................................................................................ F-5
F-8 Labeling of polygons according to elevation ........................................ F-5
F-9 Edit Point Properties ......................................................................... F-6
F-10 Edit Point Properties Dialog Box – draw features using Attribute Values F-6
F-11 Labels assigned to point shapefile ...................................................... F-7
F-12 USGS Digital Line Graph Editor ......................................................... F-8
F-13 Color Scale Options Dialog Box ......................................................... F-9
G-1 Color Chooser – Swatches tab ............................................................. G-1
G-2 Color Chooser – HSB tab .................................................................. G-2
G-3 Color Chooser – RGB tab ................................................................. G-3
## List of Tables

<table>
<thead>
<tr>
<th>Table Number</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>External Gridded Data Utilities</td>
<td>1-4</td>
</tr>
<tr>
<td>3-1</td>
<td>File Menu Options</td>
<td>3-3</td>
</tr>
<tr>
<td>3-2</td>
<td>View Menu Options</td>
<td>3-3</td>
</tr>
<tr>
<td>3-3</td>
<td>Single Grid Menu Options</td>
<td>3-4</td>
</tr>
<tr>
<td>3-4</td>
<td>Grid Set Menu Options</td>
<td>3-5</td>
</tr>
<tr>
<td>3-5</td>
<td>Data Analysis Menu Options</td>
<td>3-5</td>
</tr>
<tr>
<td>3-6</td>
<td>Data Management Menu Options</td>
<td>3-6</td>
</tr>
<tr>
<td>3-7</td>
<td>Tools Menu Options</td>
<td>3-6</td>
</tr>
<tr>
<td>3-8</td>
<td>Help Menu Options</td>
<td>3-6</td>
</tr>
<tr>
<td>5-1</td>
<td>Map Layer Formats Supported by HEC-GridUtil</td>
<td>5-2</td>
</tr>
<tr>
<td>5-2</td>
<td>Layer Commands</td>
<td>5-5</td>
</tr>
<tr>
<td>6-1</td>
<td>ArcInfo® Grid Header</td>
<td>6-9</td>
</tr>
<tr>
<td>6-2</td>
<td>ASCII Dump File</td>
<td>6-10</td>
</tr>
<tr>
<td>8-1</td>
<td>Grid Parameters</td>
<td>8-5</td>
</tr>
<tr>
<td>B-1</td>
<td>Grid Header Contents</td>
<td>B-3</td>
</tr>
<tr>
<td>B-2</td>
<td>Additional Grid Header Fields for HRAP Grids</td>
<td>B-4</td>
</tr>
<tr>
<td>B-3</td>
<td>Additional Grid Header Fields for SHG and Other Albers Grids</td>
<td>B-4</td>
</tr>
<tr>
<td>E-1</td>
<td>Coordinate Systems Available in GridUtil</td>
<td>E-3</td>
</tr>
<tr>
<td>G-1</td>
<td>HSB Rules</td>
<td>G-2</td>
</tr>
</tbody>
</table>
Acknowledgments

The Hydrologic Engineering Center's (HEC) Grid Utility program for managing gridded data with HEC-DSS (Hydrologic Engineering Center's Data Storage System), HEC-GridUtil, was developed at HEC in order to facilitate use of gridded data in CWMS (Corps Water Management System) and HEC-HMS (Hydrologic Engineering Center's Hydrologic Modeling System). GridUtil has been implemented following software guidelines established at HEC, these guidelines will produce more consistent results when using HEC software in water resources studies. Also, the guidelines facilitate a common graphical user interface and “look-and-feel” for HEC software in the PC environment. Recent HEC software implemented under these guidelines are: rainfall-runoff analysis (HEC-HMS), river hydraulics (HEC-RAS), reservoir system analysis (HEC-ResSim), flood damage analysis (HEC-FDA), flood impact analysis (HEC-FIA), statistical analysis (HEC-SSP), and, ecosystem function analysis (HEC-EFM). HEC software implementation is under the guidance of Christopher N. Dunn, Director, Hydrologic Engineering Center.

The development of GridUtil occurred at the request of Lower Colorado River Authority (LCRA), using funds provided under its Memorandum of Agreement with HEC. The program was primarily written by Mr. Mark Ackerman of Resource Management Associates (RMA), under the direction of Dr. Thomas A. Evans, Mr. Matthew M. McPherson, and Dr. Todd E. Steissberg, Hydrologic Engineering Center. It also incorporates functions written by Mr. William Charley and Mr. Carl Franke, Hydrologic Engineering Center. Functions for coordinate system and map projection transformations were written at RMA.
Foreword

The Hydrologic Engineering Center's utility program for managing gridded data with HEC-DSS (Hydrologic Engineering Center's Data Storage System), provides an interface that facilitates viewing of gridded data and performs basic utility functions on gridded data that then is stored as time-series in HEC-DSS. The structure of gridded data (raster data) is the result of converting scattered individual data points into a grid of calculated hypothetical values.
Chapter 1

Introduction

1.1 Purpose

In support of the Corps Water Management System (CWMS) modernization project, a program was developed to facilitate basic viewing, processing, and analysis of gridded data sets in HEC-DSS (Hydrologic Engineering Center's Data Storage System). This program is the Hydrologic Engineering Center's Grid Utility program, HEC-GridUtil. Sequences of grids typically approximate the variation through space of a quantity measured varying through fixed-intervals of time at fixed locations. The predominant types of gridded data in DSS are regular-interval time series of hydrologic variables distributed over a fixed geographic extent, such as Stage 3 NEXRAD (Next Generation Radar) precipitation, or mean daily temperatures throughout a basin. Storage in HEC-DSS primarily facilitates use of the data by the HEC-HMS (Hydrologic Engineering Center's Hydrologic Modeling System) model and the CWMS CAVI (Control Acquisition Visualization Interface), but also provides advantages regarding access speed, data organization, file size, portability, multi-platform support, and avoidance of requirements for licensing proprietary software.

1.2 DSS Concepts

Time series of spatial information have become increasingly important to mainstream hydrological applications, but they pose challenges regarding standardized storage and indexing. The structure of gridded data in HEC-DSS provides very efficient storage of and access to data sets of the same parameter, expressed in the same units, covering the same grid cells (in terms of spatial extent and coordinate definition) throughout a recurring constant time interval.

Each HEC-DSS file is a stand-alone database file, and can be easily shared among users and applications that recognize HEC-DSS, without platform conversions or external dependencies such as schema definitions. HEC-DSS is primarily designed to facilitate use of times-series data such as hourly water levels, or monthly mean discharge. The primary tool for managing HEC-DSS data is the HEC-DSSVue software (Hydrologic Engineering Center's Data Storage System Visual Utility Engine) (http://www.hec.usace.army.mil). HEC-GridUtil performs utility operations specific to gridded data in HEC-DSS, although many ordinary management tasks, such as copying data between HEC-DSS files or renaming records, are performed using the HEC-
DSSVue software. HEC-DSS stores gridded data according to descriptive record identifiers (i.e., pathnames), consisting of six brief descriptors:

- The A-part refers to the grid's coordinate system. The two primary spatial reference definitions are known as Hydrologic Rainfall Analysis Project (HRAP) and Standard Hydrologic Grid (SHG). Appendices D and E provide detailed descriptions of the HRAP and SHG coordinate systems. Some functions of GridUtil only support gridded data stored in HRAP or SHG.
- By convention, the B-part describes the area covered by the gridded data, such as a watershed or the region served by a National Weather Service (NWS) River Forecast Center (RFC).
- The C-part refers to the parameter represented by the grid, such as PRECIP or TEMP.
- The D-part contains the starting time of the period represented by the gridded data in the pathname, such as 01JUL2000:0500.
- The E-part contains the ending time of the period represented by the gridded data in the pathname, such as 01JUL2000:0600.
- The F-part contains user-specified identifying information distinguishing one set of grids from another. Typical conventions include information about the data source and/or some labeling indicating versioning or processing operations. For example, data obtained from the North Central River Forecast Center and then revised could have the F-part set to “NCRFC_REVISED.”

HEC-DSS assumes that the D-part and E-part of pathnames for gridded data reflect UTC (Universal Coordinated Time). Neither HEC-DSS nor GridUtil performs conversions between time zones.

In addition to the descriptors contained in the pathname, HEC-DSS records also include header information. The header identifies the units, data type, spatial definitions, and statistics regarding the data values among the cells. Appendix A contains detailed information regarding the format of gridded data stored in HEC-DSS.

### 1.3 Characteristics and Capabilities of GridUtil

HEC-GridUtil is available to the public at no cost, and without any forms of licensing or registration. The software originated as an integral part of the Corps Water Management System (CWMS), and maintains a close linkage and shared code base with HEC-ResSim (Hydrologic Engineering Center's Reservoir System Simulation), HEC-DSSVue, and other HEC models and tools.

GridUtil is written in Java, but also relies on libraries written in FORTRAN and C, which currently limit supported platforms to Microsoft Windows and Sun Solaris. HEC can accommodate other environments, such as Linux or MacOS, if funding is available and the need aligns with HEC's support mission to USACE and partners.
The primary objective of GridUtil is to provide convenient viewing and processing of gridded data. Features of the current version of GridUtil include:

- Visualizing and animating sequences of gridded data
- Importing gridded data from external files
- Exporting data to GIS (Geographic Information System) and graphics files
- Computing simple statistics, such as cumulative, mean, or maximum cell values, across grid sets over a specified time period,
- Performing basic mathematical operations, such as adding cell values across grids or multiplying a grid by a constant
- Creating a mosaic by joining overlapping or adjacent grids
- Creating a grid set by extracting a region of cells from an existing grid set
- Transforming HRAP grids to the SHG coordinate system
- Importing or exporting gridded data. This version of GridUtil includes support for importing data in ArcInfo ASCII format. Other common formats include XMRG (a binary file format used within the NWS to store gridded data), GRIB (Gridded Binary), HDP (hourly digital precipitation), and NetCDF (Network Common Data Format). XMRG and NetCDF files may be imported using the utilities provided in the “grid” folder.
- Performing operations on grids from shell scripts

GridUtil represents gridded data in two forms: single grids and grid sets. A **single grid** contains data for one time interval, while **grid sets** represent a time sequence of a certain gridded parameter sharing the same spatial definition. The map panel can superimpose the gridded data on numerous reference layer types and formats, such as shapefiles or geo-referenced JPEG (Joint Photographic Experts Group, *.jpg, *.jpeg) images.

Like HEC-DSSVue, GridUtil relies heavily on the concept of a “time window” for data operations. The period may be specified as an absolute reference (e.g., from 02Jun2007 0000 to 19Jun2007 2400), or in terms relative to the current time (the last seven days). With certain exceptions, GridUtil operates only on the data records contained within the time window.

GridUtil only performs coordinate transformations on data expressed in the HRAP or SHG systems. Gridded data with undefined or custom coordinate systems are rendered according to the cell size, number of rows and columns, and cell indices for the grid's origin. When using gridded data outside the standard spatial reference systems, you must assume full responsibility for matching the data and map coordinates.

GridUtil is designed for use by water resource engineering professionals and is tailored to tasks that occur in typical hydrologic analyses related to planning and operation of water
management projects. GridUtil is not a geospatial processing program; coordinate transforms, grid arithmetic, and spatial visualization are limited to specialized implementations relevant to hydrologic engineering applications. GridUtil is also not a dedicated research tool, although it can be used in conjunction with other tools for hydrological modeling and research applications. Computations implemented in GridUtil are very well established and as simplified as possible, implemented using a comprehensive GUI designed and tested to commercial standards.

1.4 Gridded Data Formats and Conversions

GridUtil relies on three external programs to read gridded data stored in XMRG, NetCDF, or ArcInfo ASCII (text) format. GridUtil uses these programs to store the data as DSS records and then loads these records. A fourth program can be used to convert DSS records to ArcInfo ASCII format. These programs are listed in Table 1-1.

Table 1-1 External Gridded Data Utilities

<table>
<thead>
<tr>
<th>Utility Program</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>asc2dssGrid</td>
<td>Converts gridded data stored in ESRI's ArcInfo ASCII (text) format to DSS</td>
</tr>
<tr>
<td>dss2ascGrid</td>
<td>Converts DSS grids to ArcInfo ASCII gridded data format</td>
</tr>
<tr>
<td>gridLoadNetCDF</td>
<td>Converts data stored in NetCDF</td>
</tr>
<tr>
<td>gridLoadXMRG</td>
<td>Converts National Weather Service River Forecast Center (NWS RFC) gridded data stored in XMRG format to DSS</td>
</tr>
</tbody>
</table>

These programs can be run manually from the Windows or UNIX command prompt or used in a batch script to conveniently process multiple files. As a general rule, each file contains a single grid, which results in a single DSS record.

The documentation available regarding these programs is provided in Appendix H and Appendix I.

1.5 Documentation Conventions

The following conventions are used throughout this manual to describe the GridUtil interface and operations:

- Most labeled GUI components (window titles, menu names, menu items, button names, etc.) are shown in **bold**
- Folder (directory) names are shown in **bold italics**
Chapter 2

Requirements and Setup

2.1 Hardware and Software Requirements

Before you install the HEC-GridUtil software, make sure that your computer has at least the minimum required hardware and software. In order to get the maximum performance from HEC-GridUtil, recommended hardware and software is shown in parentheses. This version of HEC-GridUtil will run on a computer that has the following:

- Intel Based PC or compatible machine with Pentium processor or higher (a Pentium 4 or higher is recommended).
- A hard disk with at least 200 megabytes of free space
- A CD-Rom drive (or CD-R, CD-RW, DVD), if installing from a CD.
- A minimum of 512 megabytes of RAM (1 Gigabyte or more is recommended).
- A mouse.
- Color Video Display (Recommend at least a 17” monitor, running 1280x1024 or higher resolution).
- Microsoft Windows XP, Vista, or Windows 7.

2.2 Installation Procedure

Installation of the HEC-GridUtil software is accomplished through the use of the Setup program.

To install the software onto your hard disk do the following:

1. Insert the HEC-GridUtil CD into your CD drive, or download the software from our web site: www.hec.usace.army.mil.
2. The setup program should run automatically if installing from a CD. When downloading from the web page you will need to save the setup file in a temporary directory and then execute the “HEC-GridUtil_20_Setup.exe” file to run the setup program.
3. If the setup program does not automatically run from the CD, use Windows Explorer to start the “HEC-GridUtil_20_Setup.exe” program on the CD.
4. Follow the setup instructions on the screen.

The setup program automatically creates a program group called HEC. This program group will be listed under the Programs menu, which is under the Start menu. The HEC-GridUtil program icon will be contained within the HEC program group, within the HEC-GridUtil subdirectory. The user can request that a shortcut icon for HEC-GridUtil be created on the desktop. If installed in the default directory, the HEC-GridUtil executable can be found in the “C:\Program Files\HEC\HEC-GridUtil\2.0” directory (for computers running 32-bit Windows) or the “C:\Program Files (x86)\HEC\HEC-GridUtil\2.0” directory (for computers running 64-bit Windows) with the name “HEC-GridUtil.exe.”

The HEC-GridUtil User’s Manual and example data sets are also installed with the software. The User’s Manual can be viewed by selecting User’s Manual from the Help menu. You must have Adobe Acrobat Reader to view the user’s manual. This viewer can be obtained for free from the Adobe web page.

A zip file containing the example data sets used in this manual have been installed in the “…\examples” folder within the program directory. You can install the example data sets by selecting the Install Example Data option from the Help menu. After selecting the Install Example Data menu option, a window will open for you to choose a location to install the example data sets. The program will create a subdirectory within your chosen folder called “HEC-GridUtil Example Watersheds.” This folder will contain a folder named “LCRA,” which contains a project file called “LCRA.wksp.”

The first time a particular user account launches GridUtil, the program displays the Terms and Conditions for Use dialog box (Figure 2-1). Please read the entire agreement carefully. Once the final line of text appears, the button indicating your agreement activates. Click OK, and the application continues.

![Figure 2-1 Terms and Conditions for Use Dialog Box](image-url)
2.3 Uninstall Procedure

The HEC-GridUtil Setup program automatically registers the software with the Windows operating system. To uninstall the software, do the following:

- From the **Start** menu select Control Panel.
- Select Add/Remove Programs from within the Control Panel folder.
- From the list of installed software, select the HEC-GridUtil program and press the Remove button.
- Follow the uninstall directions on the screen and the software will be removed from your hard disk.
Chapter 3

Using HEC-GridUtil: An Overview

3.1 HEC-GridUtil Main Window

To begin working, simply double-click the HEC-GridUtil icon. The GridUtil main window will open (Figure 3-1). This window shows the main components of the GridUtil user interface. By default, the window opens to the last module you accessed. If this is the first time you are opening the GridUtil, GridUtil will initially open to the first module you have access to.

Figure 3-1  HEC-GridUtil Main Window

The **Map Panel** displays the gridded data and optional reference layers. Whenever the pointer enters the Map Panel, the lower left corner of the interface displays the coordinates of the pointer. The **Menu Bar**, described in detail in subsequent paragraphs, contains selections for accessing the main program functions. The **Icon Bar** provides tools suited to different modes of the various functions. The **Grid Configuration Panel**
becomes active when a gridded data set is loaded. This panel describes the data set’s defining characteristics. The **Message Bar** displays information from GridUtil runs, such as certain file accesses or accuracy of coordinate system transformations. The **Status Bar** displays the coordinates of the last location of the cursor in the **Map Panel**.

The **Time Series Panel** displays time series of the mean, minimum, or maximum averages of a Grid Set. The controls at the bottom of this panel allow playing, pausing, stopping, and skipping through the gridded data. The black vertical line on the time series plot and the date and time immediately below this plot indicate the time for which gridded data will be displayed in the map panel. The starting and ending times of the selected time window are shown above the horizontal slider bar. The slider control can be dragged to quickly scan through the gridded data set. This control is disabled during playback, after the **Play** button is clicked. Click the **Stop** button before dragging the slider bar. Note that when a large Grid Set is loaded, a long delay may occur before the time series of the Grid Set is plotted.

### 3.2 Menu Bar

The menus in HEC-GridUtil allow you to load, save, view, edit, delete, and perform mathematical and other operations on gridded data sets. The menu bar is shown in Figure 3-2.

![File View Single Grid Grid Set Data Analysis Data Management Tools Help](image)

**Figure 3-2 Menu Bar**

The **File** menu allows users to create a new watershed, save changes to a watershed, or open an existing watershed. The bottom of the file menu provides a most-recently used list of projects for quick access to frequently used watersheds. The **File** menu also provides an option, called **Save Map As**, for storing a screen snapshot of the Map Panel as an image file on disk. A list of **File** menu items, describing their actions, is provided in Table 3-1.

The **View** menu allows you to modify several aspects of the display of gridded data or reference layers. A list of **View** menu items, describing their actions, is provided in Table 3-2.

The **Single Grid** menu contains several options for creating, opening, closing, importing, exporting, editing, saving, and deleting Single Grid data. A list of **Single Grid** menu items, describing their actions, is provided in Table 3-3. These operations are described in detail in Chapter 6.

The **Grid Set** menu contains several options for creating, opening, saving, closing, editing, and deleting Single Grid data. A list of **Grid Set** menu items, describing their actions, is provided in Table 3-4. These operations are described in detail in Chapter 7.

The **Data Analysis** menu contains options for time series operations, computation of mean areal value, and an expression builder to perform customized calculations. A list of
**Data Analysis** menu items, describing their actions, is provided in Table 3-5. These features are described in detail in Chapter 8.

The **Data Management** menu contains options to produce a mosaic of two or more Grid Sets, extract sub-regions from a Grid Set, and to convert HRAP grids to SHG format. A list of **Data Management** menu items, describing their actions, is provided in Table 3-6. These operations are described in detail in Chapter 9.

The **Tools** menu contains several options to assist you in working with gridded data sets. These include an option to launch HEC-DSSVue, a script browser, and a log file viewer. A list of **Tools** menu items, describing their actions, is provided in Table 3-7.

The **Help** menu provides access to selected **Help Topics** and information about this version of GridUtil. Note: the Help Topics option is disabled. This feature will be implemented in a future release. A list of **Help** menu items, describing their actions, is provided in Table 3-8.

<table>
<thead>
<tr>
<th>Table 3-1  File Menu Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Option</strong></td>
</tr>
<tr>
<td>New Watershed…</td>
</tr>
<tr>
<td>Open Watershed…</td>
</tr>
<tr>
<td>Save Map As…</td>
</tr>
<tr>
<td>Exit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 3-2  View Menu Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Option</strong></td>
</tr>
<tr>
<td>Zoom to All</td>
</tr>
<tr>
<td>Layers…</td>
</tr>
<tr>
<td>Unit System ⇒</td>
</tr>
<tr>
<td>Icons ⇒</td>
</tr>
<tr>
<td>Restore Windows</td>
</tr>
</tbody>
</table>
### Menu Option Action

<table>
<thead>
<tr>
<th>Grid Lines</th>
<th>Toggle display of map grid lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Time Window</td>
<td>Restrict operations to a specific time period; can be relative or absolute</td>
</tr>
<tr>
<td>Summary Time Series Plot</td>
<td>Specify whether to use minimum, maximum, or mean grid cell values for the time series plot</td>
</tr>
<tr>
<td>Color Contour Window</td>
<td>Display color bar</td>
</tr>
<tr>
<td>Cumulative Display</td>
<td>Toggle cumulative display to show cumulative values to date</td>
</tr>
</tbody>
</table>

### Table 3-3 Single Grid Menu Options

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>New…</td>
<td>Create new Single Grid</td>
</tr>
<tr>
<td>Open</td>
<td>Open existing Single Grid</td>
</tr>
<tr>
<td>Save</td>
<td>Save Single Grid</td>
</tr>
<tr>
<td>Close</td>
<td>Close Single Grid</td>
</tr>
<tr>
<td>Edit…</td>
<td>Change the DSS file, path, or coordinate system for the currently loaded Single Grid</td>
</tr>
<tr>
<td>Info…</td>
<td>View information for Single Grid, including coordinate system, grid size, date/time, and summary statistics</td>
</tr>
<tr>
<td>Import ➤</td>
<td>Import a single grid from an ArcInfo ASCII file</td>
</tr>
<tr>
<td>Export ➤</td>
<td>Export Single Grid to ArcInfo ASCII format or dump to an ASCII file</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete an existing Single Grid</td>
</tr>
<tr>
<td>Rename</td>
<td>Rename Single Grid</td>
</tr>
<tr>
<td>Previous</td>
<td>Reload Single Grid</td>
</tr>
</tbody>
</table>
Table 3-4  Grid Set Menu Options

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>New…</td>
<td>Create new Grid Set</td>
</tr>
<tr>
<td>Open</td>
<td>Open existing Grid Set</td>
</tr>
<tr>
<td>Save</td>
<td>Save Grid Set</td>
</tr>
<tr>
<td>Close</td>
<td>Close Grid Set</td>
</tr>
<tr>
<td>Edit…</td>
<td>Change the DSS file, path, or coordinate system for the currently loaded Grid Set</td>
</tr>
<tr>
<td>Info…</td>
<td>View information for Grid Set, including coordinate system, grid size, date/time, and summary statistics</td>
</tr>
<tr>
<td>Import</td>
<td>Import a Grid Set from DSS</td>
</tr>
<tr>
<td>Export</td>
<td>Export a Grid Set to a Grid Set Archive</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete an existing Grid Set</td>
</tr>
<tr>
<td>Rename</td>
<td>Rename Grid Set</td>
</tr>
<tr>
<td>Reload</td>
<td>Reload Grid Set</td>
</tr>
<tr>
<td>Update</td>
<td>Update display of Grid Set</td>
</tr>
<tr>
<td>Reload</td>
<td>Reload Grid Set</td>
</tr>
</tbody>
</table>

Table 3-5  Data Analysis Menu Options

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Series Functions…</td>
<td>Perform time series operations, such as averaging</td>
</tr>
<tr>
<td>Mean Areal Value…</td>
<td>Compute mean areal value of SHG grid cells</td>
</tr>
<tr>
<td>Expression Builder</td>
<td>Open Expression Builder tool</td>
</tr>
</tbody>
</table>
Table 3-6  Data Management Menu Options

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Mosaic</td>
<td>Merge two or more overlapping or adjacent grids</td>
</tr>
<tr>
<td>Extract Region</td>
<td>Extract a subset of a Single Grid or Grid Set</td>
</tr>
</tbody>
</table>

Table 3-7  Tools Menu Options

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>HEC-DSSVue…</td>
<td>Open HEC-DSSVue to view or edit grids</td>
</tr>
<tr>
<td>Scripts…</td>
<td>Open Script Browser</td>
</tr>
<tr>
<td>Console Log…</td>
<td>View, and optionally print or save, the messages that appear in the console log</td>
</tr>
<tr>
<td>Options…</td>
<td>The Options dialog allows you to set the cache directory, colors, fonts, and other features</td>
</tr>
<tr>
<td>Information…</td>
<td>Provides information about this release of GridUtil.</td>
</tr>
</tbody>
</table>

Table 3-8  Help Menu Options

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Example Data</td>
<td>Install the example watershed and data shown in this manual to a user-selected location.</td>
</tr>
<tr>
<td>About</td>
<td>Information about the GridUtil version, build number, and date of release of HEC-GridUtil</td>
</tr>
</tbody>
</table>

3.3 Map Tools

Zoom Tool: Use this tool to zoom in and out of the map panel. To zoom in, hold the left mouse button down and outline the area you want to enlarge. To zoom out, click the right mouse button (right-click). The zoom out is done by a factor of two and positions the clicked location at the center of the map panel.

Pan Tool: Use this tool to move the map panel while you are zoomed in.
**Extract Tool**: Use this tool to label data values or select regions for extraction. Single-click on a grid cell to label the value at that location. Click and drag on the map to select a rectangular region. Double-click anywhere on the map to remove value labels or the extraction rectangle.

### 3.4 Time Window

To restrict the operations of GridUtil to a specific time period, you may set the time window. To set or change the time window, select **Set Time Window** from the **View** menu. This opens the **Time Window** dialog box, shown in Figure 3-3. The time window may be specific or relative. A specific time window is defined by selecting **Specific Time Window** and setting the starting and ending dates and times. Click **Set Current Time** to set the start and end dates and times to the current date and time. To set the time window relative to the current time, e.g., the last 30 days, select **Relative to Current Time** and specify the number of hours, days, months, or years to go back or to go forward. If the time window is undefined, a message dialog will appear warning you that GridUtil could not find any data, and no data will be plotted. If you will be consistently working with the same time period, you may select **Retain Between Sessions** to retain the time window when GridUtil is closed so that it does not have to be reset every time GridUtil is opened.

![Time Window Dialog Box](image)

**Figure 3-3** Time Window Dialog Box

### 3.5 Cumulative Display

**Cumulative Display** instructs GridUtil to show the accumulated value of each cell at any point within the time window. This option is located in the **View** menu. It is most useful for precipitation analyses, such as storm totals.
Chapter 4

Getting Started

4.1 Creating a New Watershed

To create a new watershed, select **New Watershed** from the **File** menu. The **Create New Watershed** dialog box will open (Figure 4-1). In the **Name** field, enter a name for the new GridUtil project. A sub-directory with this name will be created to hold the files for the watershed, so avoid characters with special significance to the operating system. You may enter a description of your watershed or important characteristics in the **Description** field.

Click **Select Location** to select the folder in which your project’s folder will be stored. The **Select Watershed Folder** browser will open (Figure 4-2). Browse to the folder that will contain your project folder. Alternatively, you may paste the full path in the **File name** field. Click **Open**.

Next, select the units system (English or SI) and the time zone of your watershed. The **Create New Watershed** dialog box should appear as in Figure 4-2. Click **OK**. A
Watershed Summary dialog box will be displayed (Figure 4-3), showing the name, description, units system, and time zone of your new watershed. If everything looks correct, click OK to create your new watershed. A new project folder will be created for you and populated with basic information describing your new watershed.

Figure 4-3 Watershed Summary Dialog Box

4.2 Coordinate System Setup

Before gridded data can be correctly displayed, your coordinate system and map extents need to be specified. The coordinate system you choose will usually be determined by the needs of your project or the coordinate system of any GIS layers you use, as detailed in the next section.

To set your coordinate system and map extents, select Layers from the View menu. The Layer Selector will open. Select Map Display Coordinates from the Maps menu (Figure 4-4).

The Display Coordinate Information dialog box will open (Figure 4-5). Click Edit to select the coordinate system from the Map Coordinate Information dialog box (Figure 4-6). Select the coordinate system from the System option list.

Figure 4-4 Layer Selector
Depending on which coordinate system you select, the other options (i.e., the Units and Spheroid fields) in this window will change. In the example shown in Figure 4-6, the State Plane Coordinate System was selected. This requires that the Units and Spheroid be chosen from options lists, and a number entered in the Zone field. The State Plane Coordinate System of Central Texas (SPTC) corresponds to Zone 4203. Click OK to accept the changes. The Map Coordinate Information dialog box will close.

Back in the Display Coordinate Information dialog box, enter the minimum and maximum extents of your map (Figure 4-5). These can be obtained from GIS layers,
using ArcGIS, or can be automatically determined by loading one or more GIS layers, as detailed in the next section. Click **OK** to accept all changes.

### 4.3 Automatic Setting of Map Extents

This section describes how to set the map extents automatically. To begin, adjust the map extents using the magnification tool to the left of the map panel. Click and hold the left mouse button and drag the mouse pointer to zoom into the specified region. A selection box will appear to aid your selection. Release the left mouse button to complete your selection. If you wish to redo your selection, choose **Zoom to All** from the **View** menu.

In the *Layer Selector* window, select **Map Display Coordinates** from the **Maps** menu, as shown in the previous section. Uncheck **Grow to Map Extents** and click the **Set Map Coordinates to Display** button (Figure 4-7). Click **OK**, and the map extents will resize to match your display.

![Display Coordinate Information Dialog Box](image)

**Figure 4-7** Display Coordinate Information Dialog Box
Chapter 5

Using Layers

5.1 Concept of Layers

There are several types of layers available in HEC-GridUtil. Each layer is a graphic representation of a single data set. For example, if a Single Grid (see Chapter 6) is open, there will be a layer for this grid. Similarly, a Grid Set (see Chapter 7) will also be represented by a layer. GridUtil currently provides one Single Grid layer and one Grid Set layer, so only one layer of each type of gridded data may be displayed at the same time.

Map layers are used in GridUtil to provide visual references for interpreting gridded data. These may consist of Arc shapefiles, raster images, or other geographical data. In contrast to grid layers, multiple map layers may be displayed at the same time. Unlike other HEC programs, such as HEC-RAS and HEC-ResSim, HEC-GridUtil does not use stream alignment, schematic, alternatives, or other “primary” layers.

The order of the layers can be changed so that one layer plots “on top of” the other layers. The transparency of each layer can be adjusted to help visualize the layer(s) underneath. For example, you can overlay a shapefile defining the boundaries of various sub-watersheds over a precipitation Grid Set. The Grid Set can, in turn, be displayed over an aerial photograph (raster image) of the study site by adjusting the transparency of the Grid Set layer. Each layer can be turned on (displayed) or off (hidden) to aid in visualization and map customization.

5.2 Map Layers

To help you visualize a study area, GridUtil has the capability to display maps of study features. Sub-basin boundaries, watershed boundaries, and stream gage locations are just a few of the digital maps of study features that can be displayed.

5.2.1 Map Layer Formats

In GridUtil, digital maps are referred to as map layers. When a map layer is included in a watershed, the program displays it as a color picture. The map layer formats that GridUtil can display are listed in Table 5-1.
Table 5-1  Map Layer Formats Supported by HEC-GridUtil

<table>
<thead>
<tr>
<th>Description</th>
<th>Common Filename Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>USGS digital line graph</td>
<td>.dlg</td>
</tr>
<tr>
<td>Arc Shapefile</td>
<td>.shp</td>
</tr>
<tr>
<td>Raster image</td>
<td>.img, .jpg, .gif</td>
</tr>
<tr>
<td>ASCII NetTIN</td>
<td>.net</td>
</tr>
<tr>
<td>USGS DEM</td>
<td>.dem</td>
</tr>
<tr>
<td>ArcInfo® DEM</td>
<td>.asc</td>
</tr>
</tbody>
</table>

**Arc Shapefiles (.shp)**

This layer type is the native data structure for ESRI’s suite of GIS software, including ArcGIS®, ArcView®, and ArcInfo®. Shapefiles store non-topological geometry and attribute information for the spatial features of a data set. Usually there are three files associated with a shapefile: *.dbf, *.shp, and *.shx. The .shp file contains the shapes (point, polylines, or polygons) that are displayed in the layer. Each shape has a record in the .dbf file containing descriptive data called “attributes.” The .shx file contains an index that links each shape to its record in the .dbf file.

**Raster Image**

A raster image, commonly known simply as an “image” or bitmap, is a data structure consisting of a rectangular grid of picture elements (“pixels”), with each pixel representing the color value of its grid point. The raster image formats currently supported by GridUtil are the JPEG format (*.jpg, *.jpeg) and the Graphics Interchange Format (*.gif). When a raster image is imported, GridUtil creates a special ASCII (text) file (*.img), which contains the coordinates of the image boundaries, the rotation of the image in degrees (typically zero), and the location of the raster image on your file system. This file is stored in the maps folder. A sample of this file is shown in Figure 5-1. The coordinate system and units must match the coordinate system and units of your watershed. This information may be obtained or verified by opening the **Display Coordinate Information** dialog. To do this, select the **Layers** from the **View** menu. The **Layer Selector** window will open. Select the **Maps** menu at the top of this window, and then choose **Map Display Coordinates**. The **Display Coordinate Information** dialog will open, showing the coordinate system and map extents. Click the **Edit** button to view information about the coordinate system.
USGS Digital Line Graph (.dlg)

A Digital Line Graph (DLG) is a cartographic map feature, such as a basin boundary, which is stored as a vector. DLGs are derived from USGS maps and other related sources, such as aerial photographs. When HEC-GridUtil interacts with a .dlg file it automatically creates a .dlgbin file for use.

USGS DEM (.dem)

A Digital Elevation Model (DEM) is a digital representation of ground surface topography (terrain). It is also commonly known as a digital terrain model (DTM). A DEM usually represents topographic data in raster format (see definition above). However, DEMs may also store topographic data as a triangulated irregular network (TIN; see definition under NetTIN, below). DEMs are often constructed from remotely sensed data, such as aerial or satellite images. However they may also be derived from field surveys. The DEM format, published by the USGS, allows internal documentation of coordinate system, horizontal and vertical datums, date of publication, measurement units, and other items.

ArcInfo® DEM (.asc)

An ArcInfo® DEM stores digital elevation model (DEM) data (see USGS DEM, above) in an ASCII (text) file format. The file consists of a grid of elevations preceded by a header defining the number of columns, number of rows, horizontal coordinates of the lower left corner, the cell size, and a “no data” value to represent missing or omitted data.

ASCII NetTIN (.net)

A triangulated irregular network (TIN) is a vector-based representation of a topographic surface, which consists of irregularly distributed nodes and lines arranged into a network of non-overlapping triangles. An ASCII NetTIN stores the TIN in ASCII (text) format, which is a commonly used to transfer TIN data between software.

5.2.2 Adding Map Layers

You can add as many map layers as you need. However, you must make sure that all map layers use the same projection, origin (datum), and measurement units. When a map layer
is added to the study, HEC-GridUtil reads the coordinates of points, lines, and polygons on the map layer and resets the geographic extents of your study to the smallest rectangle that will contain all objects in the map layer. When adding more than one map layer, you must ensure that each data set is projected into the same coordinate system. For example, if you add a digital line graph (DLG) map layer that shows the major streams in an area, the geographical extents will change according to the projection of that DLG.

To add map layers:

1. Open the **Layer Selector** window by selecting **Layers** in the **View** menu.
2. From the **Edit** menu of the **Layer Selector**, select **Allow Layer Editing**.
3. From the **Maps** menu, select **Add Map Layers**, and a file browser will open (Figure 5-2).
4. The browser defaults to the **maps** folder, which is located in the **study** folder. The **maps** folder is where we encourage you to store your various maps and other GIS data. However, you can retrieve maps from anywhere on your file system.
5. If you want GridUtil to copy the selected map layer to the **study** folder, click **OK** to add the map layer.
6. From the **Select Map to Add** browser, optionally select the desired map layer format from the **Files of type** list, select the desired file, and click **OK**. The browser will close and the map layer will appear in the active map panel.
7. There will now be an entry for the added map layer.

![Figure 5-2 Open File Browser – Select Map to Add](image)
5.2.3 Removing Map Layers

To remove map layers:

1. From the **Edit** menu of the **Layer Selector** window, select **Allow Layer Editing**.
2. Select the layer you wish to remove.
3. From the **Maps** menu, select **Remove Map Layer**.
4. A confirmation dialog will appear. Click **OK** to remove the layer.

5.2.4 Map Layer Operations

The **Layer Selector** shows a list of map layers that are currently loaded and available for viewing. The color(s) associated with each layer are available by expanding each layer’s tree*. Click the plus (“+”) sign to the left of a collapsed layer to expand its tree. Conversely, click the minus (“-”) sign to the left of an expanded layer to collapse its tree.

A shortcut menu is available for each map layer by right-clicking on that layer. This menu provides several ways to manipulate map layers. The operations available depend on the type of map layer, since GridUtil does not provide the same capabilities to all map layer formats. The available commands are shown in Table 5-2.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand (+)</td>
<td>Expand menu tree</td>
</tr>
<tr>
<td>Collapse (-)</td>
<td>Collapse menu tree</td>
</tr>
<tr>
<td>Move to Top</td>
<td>Move the selected map layer to the top of the tree.</td>
</tr>
<tr>
<td>Move Up</td>
<td>Move the selected map layer up the tree one position</td>
</tr>
<tr>
<td>Move Down</td>
<td>Move the selected map layer down the tree one position</td>
</tr>
<tr>
<td>Move to Bottom</td>
<td>Move the active map layer to the bottom of the tree</td>
</tr>
<tr>
<td>Show Legend</td>
<td>Show the legend for the active map layer in the tree structure.</td>
</tr>
<tr>
<td>Hide Legend</td>
<td>Hide the legend for the active map layer in the tree structure.</td>
</tr>
</tbody>
</table>

* The tree provides information on the available elements of a map layer. The details provided are based on the map layer’s format.
### Chapter 5 – Using Layers  
**HEC-GridUtil User’s Manual**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Label</td>
<td>Change the label of the map layer in the Maps tab. This does not change the filename of the map layer.</td>
</tr>
<tr>
<td>Properties</td>
<td>Show the properties of the selected map layer. See Appendix F for further details on available map layer editors.</td>
</tr>
<tr>
<td>Set Scale for Zoom-in</td>
<td>Set the zoom-in visualization scale for the selected map layer.</td>
</tr>
<tr>
<td>Set Scale for Zoom-out</td>
<td>Set the zoom-out visualization scale for the selected map layer.</td>
</tr>
<tr>
<td>Remove Scale Factors</td>
<td>Disable or clear all scale settings for the selected map layer. Adamit on further details on available map layer editors.</td>
</tr>
</tbody>
</table>

#### 5.2.5 Geographic Reference for Map Layers

To maintain a geographic reference (also called a geo-reference), GridUtil uses a user-selected coordinate system, called the World Coordinate System (WCS). The WCS allows GridUtil the flexibility to use virtually any coordinates convenient for water resources studies. This superimposes a grid on layer features to establish x- and y-coordinates in WCS for each point on the layer. The x-coordinate is referred to as “easting,” and the y-coordinate is referred to as “northing.” You can select the extent of this grid, the dimensions of the cells of the grid, the measurement units of the grid, and the location of the origin of the grid. The following steps outline the process of selecting a coordinate system:

1. From the Maps menu of the Layer Selector, click Map Display Coordinates. The Display Coordinate Information dialog box will open (Figure 5-3).

2. This dialog contains the following:
   - **Coordinate System.** This box identifies the established coordinate system for a study. To edit the coordinate system, click Edit, and the Map Coordinate Information dialog box (Figure 5-4) will open. See Appendix E for details on editing the coordinate system. Remember that all layers must exist in one unified coordinate system.
   - **Extents – Easting Minimum and Maximum; Northing Minimum and Maximum.** These values indicate the location of the left, right, bottom and top borders (respectively) of the grid in the map panel.
- **Grow to Map Extents.** When selected, GridUtil automatically sets the geographic extents to define the smallest rectangle that encompasses all the objects in the study.

**Set Map Coordinates to Display.** This will set the limits of the map panel. If you zoom in on an area, and click **Set Map Coordinates to Display**, the *Map Default Properties for [StudyName]* dialog box extents will change to the zoomed area.

![Display Coordinate Information Dialog Box](image)

![Map Coordinate Information Dialog Box](image)

**Figure 5-3  Display Coordinate Information Dialog Box**

**Figure 5-4  Map Coordinate Information Dialog Box**

Note that the geographic extents of your layers must be selected carefully to ensure that the entire study is included. Furthermore, the extents you specify and the coordinate system you use must be consistent across all the layers. Therefore, you may need to use GIS tools to transform the layers from one coordinate system to another before using them with GridUtil. **GridUtil has no coordinate system transformation (projection) tools.**
5.3 Layer Visualization Scaling

Layers may be set to become visible or invisible as you zoom in or out on the active map panel. Generally, this capability allows you to display finer levels of detail as you zoom in on regions in the map panel and avoid clutter when displaying the full area. This might include detailed map layers to become visible, and raster or other images to appear that are not as distinguishable at a courser zoom level.

In order to display a layer only when the map panel zooms in to a specific level, use the zoom tool and set the map panel to reflect the resolution at which the reference data should appear. Then right-click the layer in the Layer Selector, and choose Set Scale for Zoom-in. If you zoom out, the layer will disappear. Zooming back in will cause it to display again.

The option Set Scale for Zoom-out works similarly. Adjust the map panel to the zoom level at which the reference layer should come into view when zooming out. Right-click the layer and set the scale for zoom-out. Now the data will only be visible at this resolution or greater. If you zoom in, the reference layer disappears.

The option to Remove Scale Factors unsets these zoom levels.

5.3.1 Setting Visualization Scales – Vector Layers

The following steps outline how to set the visualization scale for vector map layers, such as ArcGIS shapefiles:

1. From the map panel, zoom in to the point at which you want the map layer to become visible.
2. Open the Layer Selector by selecting Layers from the View menu.
3. From the Layer Selector, right-click on the map layer. From the shortcut menu, click Set Scale for Zoom-in. The visualization scale is set automatically for that map layer.
4. If you go to the map panel and zoom out, the map layer you selected will no longer display. Conversely, if you want the map layer to become visible as you zoom out, from the shortcut menu click Set Scale for Zoom-out.
5. Visualization scale settings can be cleared or disabled for a map layer. From the shortcut menu, click Remove Scale Factors to remove the current visualization scale for that particular map layer.
5.3.2 Setting Visualization Scales – Raster Images

The following steps outline how to set the visualization scale for raster image layers:

1. From the View menu, choose Layers to open the Layer Selector.

2. Right-click on an image layer to open a shortcut menu. Select Properties. The Image Properties dialog box will open.

3. Select the Scale tab (Figure 5-5). Both zoom-in and zoom-out scale factors can be set in this tab. By default, the map layer is set to Always show layer. To set visualization scales, click Only show layer in the following scale range.

4. To set the scale so that the map layer becomes visible as you zoom in, you can set the scale to the current scale by clicking Set to Current. If you wish to enter a value, from the Only visible below 1 box enter the scale factor.

5. To set the scale so that the map layer becomes visible as you zoom out, you can set the scale to the current scale by clicking Set to Current. If you wish to enter a value, from the Only visible above 1 box enter the scale factor.

6. Click OK. The map layer specific properties dialog box closes, and the visualization scale is set for the map layer.

Figure 5-5 Image Properties Dialog Box – Scale Tab
Chapter 6

Single Grid Data

A Single Grid consists of a single layer, instance, or time interval of gridded data. Therefore, a Single Grid references a single HEC-DSS path name. Examples of Single Grids include impervious surface data and topographic data, which may be considered constant over long periods of time. However, data recorded at a single time interval, such as precipitation or temperature data derived from a single remotely sensed image can also be represented by Single Grids. A single grid can be displayed simultaneously along with a Grid Set (see Chapter 7), which contains gridded data that could vary over a time window.

6.1 Single Grid Menu

The Single Grid menu contains several commands for working with Single Grid data. These commands are summarized in Table 3-3 on page 3-3. The New command allows you to create a new Single Grid from gridded data contained in a DSS file. This is discussed in more detail in Section 6.2. Open allows you to open a Single Grid that has been previously created and saved by GridUtil. Save lets you save your changes. Close closes a Single Grid. Edit allows you to change the DSS file, path, or coordinate system for the currently loaded Single Grid. Info allows you to view information about a Single Grid, including coordinate system, grid size, date/time, and summary statistics. Import lets you import a Single Grid into DSS from another file format, as shown in Section 6.5. Delete lets you delete an existing Single Grid. Rename allows you to rename a Single Grid. Use Reload to reload a Single Grid.

6.2 Creating a New Single Grid

To load a Single Grid from a DSS file, a new Single Grid must be created and given the DSS path of the gridded data. If the gridded data set is not contained in a DSS file, you will need to import the gridded data into DSS first, as shown in Section 6.5.

To create a new Single Grid, select New from the Single Grid menu. The Create a New Single Grid dialog box will open (Figure 6-1). It lists any single grids already associated with the current watershed. Enter a name and (optionally) a description for the grid, and then click the New button.

The Set Configuration dialog box will open (Figure 6-2). In the DSS File field, enter the name of a DSS file that contains the gridded data, or click the browse button to the right
Figure 6-1  Create a New Single Grid Dialog Box

of box to select the DSS file. Next, click the button to the right of the DSS Path field; this will bring up a list of the DSS paths available in the file. After selecting the desired record, click the Set Pathname button at the bottom of the chooser to populate the DSS Path field in the Set Configuration dialog box. Close the DSS path chooser when complete.

Figure 6-2  Set Configuration Dialog Box

If the A-Part of the selected record is “HRAP” or “SHG,” the coordinate system will be automatically set. Otherwise, it will default to “Custom.” The thumbnail below the Coordinate System field should provide a quick display of the data in the pathname. Click OK when you have finished selecting the data.
Alternatively, you can view a Single Grid by filling in the identifying information on the Single Grid tab of the Gridded Data Configuration panel, located to the right of GridUtil’s main window (Figure 6-3). If desired, save the Single Grid definition by clicking the Save button and providing the name and description.

GridUtil will display the Single Grid according to a default color scale. Clicking the Single Grid tab of the Gridded Data Configuration panel will display the characteristics of the loaded data.

6.3 Displaying a Single Grid

Depending on the settings for the map coordinates, the gridded data may be located outside the extents of the current display. If you don’t see any data in the map panel, open the Layer Selector (Figure 6-4) by selecting Layers… from the View menu. From the Maps menu of the Layer Selector, click Map Display Coordinates, and the Display Coordinate Information dialog box will open (Figure 6-5).

The example in Figure 6-5 shows the coordinate system defined as “X-Y.” This simply means that the display is not tied to a geo-referenced coordinate system, so GridUtil will not apply any coordinate transformations to plot HRAP or SHG gridded data on the map. Figure 6-6 shows an example of the State Plane coordinate system used by the LCRA example data distributed with GridUtil.
Figure 6-4  Layer Selector

Figure 6-5  Display Coordinate Information Dialog Box, X-Y coordinates
To reset the map display to encompass the loaded gridded data, uncheck and re-check the box labeled **Grow to Map Extents**. Click **OK** to close the **Display Coordinate Information** dialog box (Figure 6-5), and see if the main GridUtil map panel now shows the gridded data.

If the display still does not show any gridded data, check to make sure the color scale matches the range of cell values in the gridded data and that the time window is set correctly. The **Color Scales** window (Figure 6-7) floats free from GridUtil’s main window, and can be toggled on or off from the **View** menu.

Click **Options** for the color scale labeled **Single** to open the **Grid Display Options** dialog box (Figure 6-8 and Figure 6-9), and make sure that the settings for the **Tic Interval**,** Maximum**, and **Minimum** values adequately reflect the range of the gridded cell values (given in the panel labeled **Gridded Data Configuration**).

For example, **Grid Display Options** dialog shown in Figure 6-9 set the color scale to span from 0% (green) to 100% (white). The **Reversed** checkbox is checked to use darker colors for larger values. Click **Advanced** in the **Grid Display Options** dialog to change the minimum and maximum values, brightness, saturation, transparency, and other aspects of the color scale.
Figure 6-8  GridUtil Main Window with Display Options Dialog Box

Figure 6-9  Grid Display Options Dialog Box
6.4 Displaying Cell Values

The values contained in individual grid cells can be displayed in two ways. Simply hovering the cursor over a cell displays the value, as shown in Figure 6-10.

![Figure 6-10 Display Cell Value](image)

Cell values at one or more locations can be labeled using the Extract Tool, as shown in Figure 6-11. To do so, select the Extract Tool to the left of the main window and then left-click on one or more locations on the grid. The value of each selected grid cell is displayed, and the label for that value remains on the display. To remove the labels, double click anywhere on the grid.

![Figure 6-11 Display Multiple Cell Values](image)
6.5 Importing Single Grid Data

HEC-GridUtil is most commonly used to work with gridded precipitation data provided by a National Weather Service River Forecast Center (NWS RFC). Such data commonly arrives in the form of “XMRG,” “GRB,” or “NetCDF” files. GridUtil (Figure 6-12) imports this data into DSS using small, specialized executables, such as GridLoadXMRG.exe.

These programs perform well as part of an automated system for background processing of large amounts of incoming real-time data, which is the usual situation for storing gridded data into DSS. Maintaining them as separate executables allows them to be updated independently, as the targeted data formats evolve.

These programs are included with GridUtil in the grid folder of the installation. The documentation for these utilities is included in Appendix H and Appendix I. GridUtil simply takes user input and runs the importing programs as an external process in order to import gridded data into DSS. This proves convenient for occasional storage of limited amounts of gridded data. For frequent handling of large number of files, users should automate the process with a shell script or “.bat” file.

6.5.1 XMRG Grids

This very common data type often holds Stage 3 precipitation data from NWS RFCs. GridUtil stores such data with GridLoadXMRG.exe.

6.5.2 ASCII Grids

Although NWS precipitation products are the most common type of gridded data imported into DSS records, in reality any gridded dataset can be stored in DSS if presented in the standard ASCII format used by the ArcInfo® ASCIIGRID command. The files consist of a six-line header followed by an array of values laid out like an image of the grid. The six header lines are shown in Table 6-1.
Table 6-1  ArcInfo® Grid Header

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCOLS</td>
<td>Number of grid columns (integer)</td>
</tr>
<tr>
<td>NROWS</td>
<td>Number of grid rows (integer)</td>
</tr>
<tr>
<td>XLLCORNER</td>
<td>Lower-Left X Coordinate (real)</td>
</tr>
<tr>
<td>YLLCORNER</td>
<td>Lower-Left Y Coordinate (real)</td>
</tr>
<tr>
<td>CELLSIZE</td>
<td>Cell size (real)</td>
</tr>
<tr>
<td>NODATA_VALUE</td>
<td>Indicates missing or masked data</td>
</tr>
</tbody>
</table>

This flexibility allows DSS to serve as an exchange medium for a variety of gridded hydrologic variables, such as precipitation bias or lapse rates.

GridUtil stores such data with asc2DSSGrid.exe. Best results are obtained by projecting each grid into a consistent Standard Hydrologic Grid (SHG) or Hydrologic Rainfall Analysis Project (HRAP) coordinate system. Some issues may arise regarding the units, parameter types, time period associated with the gridded data, and coordinate system (if not SHG or HRAP). Users can often work around such problems with experimentation, although allowance must be made for mislabeling of units. For instance, even though a grid of soil moisture expressed in terms of percent saturated could be stored in DSS, GridUtil may not be able to work with it unless the units are set to “mm.”

6.6 Exporting Single Grid Data

Single Grid data may be exported from DSS records for use in an external program. HEC-GridUtil supports data export in two ASCII formats.

6.6.1 ArcInfo ASCII Grid

ArcInfo® ASCII grid files consist of a six-line header followed by an array of values laid out like an image of the grid. The six header lines are shown above in Table 6-1. To export a Single Grid to this format, select the Single Grid menu, then select Export, then select ArcInfo ASCII. A file browser window will open. Enter a filename for the exported data, and then press OK.

6.6.2 ASCII Dump

Single Grid data may be “dumped” to an ASCII file. This file consists of eight header lines followed by the ASCII data. Each ASCII data point is written to a separate line. The first portion of a sample ASCII dump file is shown in Table 6-2. To export a Single Grid
to this format, select the **Single Grid** menu, then select **Export**, then select **ASCII Dump**. A file browser window will open. Enter a filename for the exported data, and then press **OK**.

**Table 6-2  ASCII Dump File**

```
<table>
<thead>
<tr>
<th>Grid Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid X base = -3020</td>
</tr>
<tr>
<td>Grid Y base = 7620</td>
</tr>
<tr>
<td>Grid X size = 2040</td>
</tr>
<tr>
<td>Grid Y size = 1680</td>
</tr>
<tr>
<td>Grid total size = 3427200</td>
</tr>
<tr>
<td>Length Data = 3427200</td>
</tr>
</tbody>
</table>

(x,y) = value >> position

(-1496,7620) = 0.0 >>1524
(-1495,7620) = 0.0 >>1525
(-1494,7620) = 0.0 >>1526
(-1493,7620) = 0.0 >>1527
(-1492,7620) = 0.0 >>1528
```
Chapter 7

Grid Sets

Grid Sets contain time series of two-dimensional gridded data. Each record in a Grid Set contains a grid of values, and each record is defined by a separate DSS path name. The data can either be instantaneous values recorded at a particular time, e.g., air temperature, or data recorded or averaged over a time interval, e.g., hourly averages of precipitation. Grid Sets can represent time series of Single Grids, where the value of each grid cell may vary during the time window. A Grid Set can be displayed simultaneously along with a Single Grid (Chapter 6).

7.1 Grid Set Menu

The Grid Set menu contains several commands for working with Grid Set data. These commands are summarized in Table 3-4 on page 3-5. The New command allows you to create a new Grid Set from gridded data contained in a DSS file. This is discussed in more detail in Section 7.2. Open allows you to open a Grid Set that has been previously created and saved by GridUtil. Save lets you save your changes. Close closes a Grid Set. Edit allows you to change the DSS file, path, or coordinate system for the currently loaded Grid Set. Info allows you to view information about a Grid Set, including coordinate system, grid size, date/time, and summary statistics. Export allows you to save a Grid Set for use in another watershed or application. Import lets you import a Grid Set, as shown in Section 7.4.2. Delete lets you delete an existing Grid Set. Rename allows you to rename a Grid Set. Use Reload to reload a Grid Set. Use Update to update the display of Grid Set data in the Map Panel.

7.2 Creating a Grid Set

A set of sequential grids introduces the dimension of time to the display. Before defining the Grid Set, check the setting of the GridUtil time window, from the View menu, click Set Time Window. By default, the beginning and ending DSS records in a Grid Set will follow the time window setting made in the dialog in Figure 7-1. This behavior mimics standard handling of time series data in HEC-DSSVue. In fact, the Time Window dialog box is exactly the same as in HEC-DSSVue.

Unlike regular time series data, Grid Sets can also be defined with a specific fixed time range as part of their specifications. In this case, the definition inside the Grid Set overrides the time window of the GridUtil application.
To create a new Grid Set:

1. To set the unit system, from the View menu point to Unit System and then click English or SI.

2. Set the time window to span your data set.

3. Select New from the Grid Set menu. The Create a New Grid Set dialog box (Figure 7-2) will open, which lists any grid sets already associated with the current watershed, and allows you to enter a name and optional description for a new Grid Set.

4. Click New, the Create a New Grid Set dialog will open (Figure 7-3).

5. Click the Add Files button to browse the file system and select multiple DSS files. Often the databases are organized by month, and the records for the period of interest span two or more DSS files. Figure 7-3 displays the Select Grid Set dialog box with three precipitation DSS files selected from the examples/LCRA folder.
6. Use the Grid Set Identifier section to set the DSS path parts to reflect the dataset of interest. As each field is defined, the choices in the remaining fields will be filtered to reflect the available pathnames that still fit the mask. The Pathname List button at the bottom left corner displays all the records in a given DSS file that satisfy the pathname mask at any given time.

7. After defining the pathname parts, verify that the controls for Time Interval, Instantaneous, and Coordinate System reflect the correct information.

8. The next section concerns setting color scale limits for displaying the data. This example establishes no limits. Limits can be set to stretch a smaller range of values across the color scale. This can enhance the display, clarify gradients, and diminish the effects of outliers or other extreme data points. The final section of the Select Grid Set dialog allows specification of a fixed time window as part of the grid definition. When complete, select OK to load.

9. If the selected records contain large grids, and the time window includes many records, GridUtil may require a few minutes to process the data.

7.3 Displaying a Grid Set

After the Grid Set is loaded, the Color Scales window (Figure 7-4) will show an additional color ramp for the Grid Set, as seen in Chapter 6.
To adjust the color scale options:

1. Click the **Options** button on the *Color Scales* window to bring up the *Grid Display Options* dialog, shown in Figure 7-5. The drop-down list at the top-left of this window can be used to select from several color scales, including precipitation and Terrain scales that match scales commonly used by GIS software to plot these types of gridded data.

2. The tic interval and minimum/maximum units can be specified, or the system specified defaults may be used.

3. Click the **Advanced** button to adjust properties of the color scale, such as brightness, saturation, and transparency. Maximum and minimum clipping values and colors can also be set. For example, the maximum clipping value can be set at 5.0 with a color of white. This will set GridUtil to plot all grid cells with a value greater than 5.0 in white. Click **OK** to accept the new settings.

The **Grid Set** tab of the *Gridded Data Configuration* panel in the GridUtil's main window contains a **Summary Time Series Plot** of the gridded records, as seen in Figure 7-6. By default, the value plotted at any given time interval represents the maximum of all the cells in that grid. The plot values can be toggled to the maximum or minimum cell values across each grid using the choices available under the **View** menu and then the **Summary Time Series Plot** menu.

Use the animation controls in the *Gridded Data Configuration* panel to play, pause, stop, fast-forward, rewind, or skip through the animation. Alternatively, drag the slider control under the time series plot, to move back and forth through the time window. If playing the animation, the stop button must be pressed in order to drag the slider control. Locations previously labeled in the map panel update as the program steps through each time interval.

If the Grid Set color scale is set as semi-transparent and appears above the Single Grid on the **Layers menu**, the Single Grid data set (if present) remains visible underneath the precipitation data.
Changing the time window (by clicking View and then Set Time Window) will cause the Grid Set to reload and display data for the new period.

7.4 Exporting and Importing Grid Sets

This section will describe how to export and import previously made Grid Sets.

7.4.1 Export a Grid Set

Grid Sets can be packaged and exchanged among GridUtil users. To export a Grid Set, first load it into GridUtil, and then choose Export from the Grid Set menu. The Export Grid Set dialog will appear (Figure 7-7).
Enter a name for the output file in the **Output File** field or browse for an existing file in the file system by pressing the browse button to the right of this field. In the **DSS Data** panel, select the appropriate option button. All records may be exported, or only the records in the Grid Set’s time window may be exported. The exported Grid Set is saved to the specified output file, with a *\texttt{.gda}* extension.
7.4.2 Import a Grid Set

To import a Grid Set, choose Import from the Grid Set menu. The Import Grid Set dialog is shown in Figure 7-8.

Enter a name for an existing Grid Set Archive File field, or browse for the file using the browse button to the right of this field. In the DSS Data panel, select whether to leave the data in the archive DSS file or to import into an existing DSS file.

Figure 7-8 Import Grid Set Dialog Box
Chapter 8

Data Analysis

HEC-GridUtil allows you to perform basic data analysis functions on gridded data. Time series functions can be used to compute the mean, minimum, maximum, range, or accumulation over a specified interval. A new time series of grids can be generated, or a single grid can be computed, summarizing the entire period. For example, a time series of grids of daily maximum precipitation values can be computed from hourly precipitation data, or a single grid of precipitation can be computed for one month. The mean areal value function allows you to compute time series of the mean areal value for multiple sub-basins, over a specified time window. The sub-basins are specified using a grid cell parameter file.

8.1 Time Series Functions

GridUtil provides several time series functions that can be applied to a Grid Set to compute statistics over a specified time window. Click the Data Analysis menu and select Time Series Functions. The Time Series Functions dialog box, shown in Figure 8-1, will appear.

Figure 8-1 Create Single Grid of Daily Accumulated Precipitation
The **Input Grid Set** field will display all Grid Sets available in *gridUtil* subfolder located in the folder for your current project. You do not need to open or import a Grid Set into GridUtil prior to using these functions. Select the Grid Set you wish to use from this list.

You can select from five possible time series functions from the **Function Field**: Accumulation, Range, Maximum, Minimum, and Mean. The range, maximum, minimum, and mean are standard statistical measures computed over the specified time interval. The accumulation is the cumulative sum over each interval. This is typically applied to data of type PER-CUM, such as precipitation data. Either a Single Grid can be computed for the entire time window, or a Grid Set (time series) can be produced, applying the function you selected to create daily, monthly, or yearly averages.

Figure 8-1 shows a **Time Series Functions** dialog set up to compute a Single Grid of accumulated precipitation for the first week of June, 2007. To create a Single Grid, select the option button next to **Make One Record**, and uncheck the **Create Grid Set** checkbox. Enter a DSS output filename in the **DSS File** field. Click the **Set Header Info…** button to set the **Units** and **Grid Type**. The boxes at the bottom of this dialog show the DSS path. Make sure the **Parameter** and **Version** boxes include the correct information. Then click **OK**. The computed grid set can be viewed in GridUtil using the **DSSVue** utility, available from the **Tools** menu. The data set is stored in a DSS file in the main folder of your watershed. The new Single Grid can also be imported into GridUtil, as described in Chapter 6.

Figure 8-2 shows a **Time Series Functions** dialog box set up to compute a time series of daily averages of precipitation for August 15 – 20, 2007.

![Figure 8-2 Create Grid Set of Daily Mean Precipitation](image)
To create a Grid Set, click the Make Time Series option button and check the Create Grid Set checkbox. Enter a Grid Set name and DSS output file name in the Grid Set Name and DSS File fields, respectively. Click the Set Header Info… button to set the Units and Grid Type. The boxes at the bottom of this dialog show the DSS path. Make sure the Parameter and Version fields include the correct information, and then click OK. A dialog will appear, asking if you want to open the new Grid Set. If you do not wish to open the Grid Set immediately, it can be opened later, as described in Chapter 7.

Alternatively, the computed grid set can be viewed in GridUtil using the DSSVue utility, available from the Tools menu.

The examples above demonstrated applying time series functions to an absolute time window. To apply time series functions to a relative time window, click the Relative option button. Next, specify the length of the time interval in the Length field and select the units of this interval. Figure 8-3 shows a Time Series Functions dialog box set up to compute a Grid Set of maximum daily precipitation for the past fourteen days.

Figure 8-3 Create Grid Set of Daily Maximum Precipitation
8.2 Mean Areal Value

You can use GridUtil to compute time series of the mean areal value for multiple sub-basins, over a specified time window.

The sub-basins must be defined in a grid cell parameter file. This is an ASCII (text) file that specifies several parameters for each sub-basin for each grid cell that it overlaps. A sample grid cell parameter file is shown in Figure 8-4. The first row of the file is a header specifying the value each column contains. This header is ignored by GridUtil. Each sub-basin record consists of a header, giving the name of the sub-basin, followed by one or more lines defining several parameters for each grid cell that the sub-basin overlaps. The sub-basin records in this file are separated by END: statements. The data columns are defined in Table 8-1.

| PARAMETER ORDER: Xcoord Ycoord TravellLength Area SCS CN |
| END: |
| SUBBASIN: PB-03 |
| GRIDCELL: -173 512 34.384348 0.675668 0 |
| GRIDCELL: -173 513 35.345062 1.950087 0 |
| GRIDCELL: -172 509 28.836309 0.047613 0 |
| END: |
| . . . . . . |
| . . . . . . |
| . . . . . . |
| END: |
| SUBBASIN: PB-05 |
| GRIDCELL: -160 500 37.034953 0.449857 0 |
| GRIDCELL: -160 501 37.554375 0.005171 0 |
| GRIDCELL: -160 501 37.034953 0.000190 0 |
| . . . . . . |
| . . . . . . |
| . . . . . . |
| END: |

Figure 8-4 Grid Parameters File
### Table 8-1 Grid Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Xcoord</td>
<td>X-coordinate (grid column)</td>
</tr>
<tr>
<td>Ycoord</td>
<td>Y-coordinate (grid row)</td>
</tr>
<tr>
<td>TravelLength</td>
<td>Travel length of flow</td>
</tr>
<tr>
<td>Area</td>
<td>Area of the sub-basin that overlaps the grid cell at (Xcoord,Ycoord)</td>
</tr>
<tr>
<td>ScsCN</td>
<td>Soil Conservation Service (Natural Resources Conservation Service, NRCS) Curve Number</td>
</tr>
</tbody>
</table>

If more than one sub-basin overlaps a grid cell, this grid cell is listed once for each sub-basin, defining the parameters for each sub-basin.

After the grid cell parameters file is defined, click the **Data Analysis** menu and select **Mean Areal Value**. The **Mean Areal Value** dialog box, shown in Figure 8-5, will appear. The **Input Grid Set** field will display all Grid Sets available in the gridUtil subfolder located in the folder for your current project. You do not need to open or import a Grid Set into GridUtil prior to using this function. Select the Grid Set you wish to use from this list.

![Mean Areal Value Dialog Box](image-url)
In the **Grid Cell Parameter File** field, type the name of your grid cell parameter file, or click the browse button to the right of this field to browse for this file in your file system.

In the **Time Window** panel, select the radio button for **Absolute** or **Relative** time window, and enter the appropriate information to define the time window to be used to compute the mean areal value of each sub-basin. Click **Set Header Info...** to set the **Units** and grid **Type**. Finally, fill in the appropriate parts of the DSS path at the bottom of this dialog box, and then click **OK**.

Time series for each sub-basin can be viewed using HEC-DSSVue or the **DSSVue** utility, which can be opened from the **Tools** menu.
Chapter 9

Data Management

HEC-GridUtil provides two data management features for altering the extent of gridded data. The data mosaic feature allows stitching of two or more gridded data sets together to form a larger grid. The extract region function allows extracting a smaller portion out of a gridded data set. This can help conserve memory and system resources and increase computation speed, particularly when working with extensive gridded data sets.

9.1 Data Mosaic

GridUtil's Data Mosaic tool allows you to create a mosaic of multiple Grid Sets, for a selected absolute or relative time window. This is helpful if your basin is covered by sections of two or more data sets. The Data Mosaic tool allows you to specify an overlap rule to handle areas where two or more Grid Sets overlap one another. The list of selected grid sets can be rearranged, and then the list order can be used to specify the order of precedence. If two or more Grid Sets overlap, the values of the Grid Set higher in the list will be placed in the mosaic. Alternatively, the average, maximum, minimum, or average of non-zero values can be computed for overlapping areas.

Open the Data Management menu and select Data Mosaic to open the Data Mosaic dialog box (Figure 9-1). Available Grid Sets in the current workspace are listed in the top-left panel of this dialog. Select the Grid Sets to use to create the mosaic, and click the Add button.

Figure 9-1  Data Mosaic Tool
Each selected Grid Set will appear in the Selected Grid Sets panel in the top-right panel of the Data Mosaic dialog and will disappear from the list of available Grid Sets at the top-left of this dialog. If you wish to remove a Grid Set from the Selected Grid Sets list, click on the item you wish to remove, and click the Remove button. The order of the Grid Sets can be rearranged by selecting a Grid Set in the Selected Grid Sets list and moving it up or down, using the arrows to the right of this panel. The order of the selected Grid Sets is important if List Order is selected for the overlap rule, as described below.

Before creating a mosaic, GridUtil needs to know how to handle areas where two or more Grid Sets overlap. For each grid cell where two or more Grid Sets overlap, the output value for the mosaic will be determined from the selected overlap rule. Click the Overlap Rule drop-down list. There are five choices, including List Order, Average Value, Max. Value, Min. Value, and Average of Non-Zero Values. If List Order is selected, the output value for the mosaic will be selected from the Grid Set listed highest in the Selected Grid Sets list. If the Average rule is selected, the output value for the mosaic will be the average of the overlapping Grid Sets. Similarly, the Max. Value and Min. Value rules will compute the maximum or minimum, respectively. The Average of Non-Zero Values rule will set GridUtil to ignore zero values in overlapping areas when computing the average.

After selecting the Grid Sets for the mosaic and specifying the overlap rule, specify the time window to use for the mosaic in the Time Window panel of the Data Mosaic dialog. Select the Absolute or Relative option button to specify an absolute or relative time window, respectively.

To create an output Grid Set:

1. Click the Create Grid Set checkbox.
2. Enter a name for the output Grid Set in the Grid Set Name field.
3. Enter a name for the output DSS file in the DSS File field, or browse for an existing DSS file using the browse button to the right of this field.
4. Click the Set Header Info… button to set the Grid Units and Grid Type.
5. Enter names for the parts of the DSS path in the Location, Parameter, and Version fields.
6. Finally, click OK to create the mosaic. An example of a mosaic of two precipitation data sets is shown in Figure 9-2.

9.2 Extract Region

GridUtil's Extract Region tool allows you to extract a sub-region from an existing Grid Set, which can save considerable memory and system resources, while speeding up computations involving the gridded data. This function is particularly useful following...
creation of a mosaic using the **Mosaic Tool**, allowing you to extract a time series of grids for your area of interest from a significantly larger Grid Set.

A plot of a precipitation data set covering the state of Texas is shown in Figure 9-2.

To extract a sub-region:

1. Click the **Extract Tool** button to the left of the map panel. Click and drag on the map to select the region to extract, as shown in Figure 9-3.
2. Next, open the **Data Management** menu and select **Extract Region** to open the **Extract Region** dialog box (Figure 9-4). The **Input Grid Set** list at the top of the **Extract Region** dialog box lists all the Grid Sets available in your current workspace. The currently loaded Grid Set is selected by default. However, you can select a different Grid Set from this list.

![Figure 9-4 Extract Region Dialog Box](image)

3. The coordinates selected with the Extract Tool are shown in the fields in the **Output** box of the **Extract Region** dialog box. To change the selection, click in one of the boxes, then either type in new coordinates, or click and drag on the map using the Extract Tool.

4. Specify the time window to use for the extracted Grid Set in the **Time Window** panel of the **Extract Region** dialog. Select the **Absolute** or **Relative** option button to specify an absolute or relative time window, respectively.

5. To create an output Grid Set, click the **Create Grid Set** checkbox, and then enter a name for the output Grid Set in the **Grid Set Name** field. Then enter a name for the output DSS file in the **DSS File** field, or browse for an existing DSS file using the browse button to the right of this field. Click the **Set Header Info** button to set the **Grid Units** and **Grid Type**. Finally, enter names for the parts of the DSS path in the **Location**, **Parameter**, and **Version** fields.

6. Finally, click **OK** to create the extracted Grid Set. An example of the extracted Grid Set is shown in Figure 9-5.
Figure 9-5  Extracted Region in Map Panel
Appendix A

References


Appendix B

Grids in DSS

B.1 Identifying Grid Records in DSS

Grid records in DSS are named according to a naming convention that differs slightly from the convention for time-series or paired-data records. Grids represent data over a region instead of at a single location and one grid record contains data for a single time interval or instantaneous value. The naming convention assigns the six pathname parts as follows.

- **A-part**: Refers to the grid reference system. At present, GageInterp supports only the HRAP and SHG grid systems (see Appendices D and E). Other grid systems will be necessary for work outside the conterminous United States.

- **B-part**: Contains the name of the region covered by the grid. For radar grids, this could be the name of the NWS River Forecast Center that produces the grid. For interpolated grids, this could be the name of a watershed.

- **C-part**: Refers to the parameter represented by the grid. Examples include PRECIP for precipitation, AIRTEMP for air temperature, SWE for snow-water equivalent, and ELEVATION for ground surface elevation.

- **D-part**: Contains the start time. This is the starting time of the interval covered by the grid. The date and time are given military-style (DDMMYYMM for date and HHMM for time on a twenty-four hour clock) and the date and time are separated by a colon (:). All times for grids should be given as UTC. Midnight is represented by 0000 if it is a starting time and 2400 if it is an ending time.

- **E-part**: Contains the end time. This is the ending time of the interval covered by the grid. The E part is blank for grids of instantaneous values.

- **F-part**: Refers to the version of the data. The version identifies the source of the data or otherwise distinguishes one set of grids from another. Version labels include STAGEIII for NWS stage III radar products, and INTERPOLATED for grids produced by GageInterp.

Some examples of DSS grid pathnames follow.

The pathname below names an SHG precipitation grid for the Rogue River basin for the hour ending at 1900 UTC on May 3, 2003. The Rogue basin is in Oregon, so the grid
represents the hour ending at noon local (Pacific Daylight) time. This grid was generated by GageInterp.

/SHG/ROGUE/PRECIP/03MAY2003:1800/03MAY2003:1900/GAGEINTERP/

The pathname below names a precipitation grid for the Missouri River basin for the hour ending at 0100 UTC. The grid comes from the Missouri Basin River Forecast Center, and is a product of the NWS's multi-sensor precipitation estimate.

/HRAP/MBRFC/PRECIP/22SEP2004:0000/22SEP2004:0100/MPE/

The pathname below names an HRAP grid representing a Quantitative Precipitation Forecast over the Ohio River Basin. This is a NWS product from the Ohio River RFC, and it covers the twenty-four hour period from noon June 1, 2001 to noon June 2, 2001 (UTC).

/HRAP/OHRFC/PRECIP/01JUN2001:1200/02JUN2001:1200/QPF/

The pathname below names an SHG temperature grid for the Rogue River basin. The cell size in this grid is 1000 meters instead of the default 2000 meters for SHG. Because the temperature is an instantaneous value at 0800, the E-part of the path is blank.

/SHG1K/ROGUE/AIRTEMP/22FEB2002:0800//GAGEINTERP/

### B.2 Contents of a Grid Record in DSS

HEC-DSS records, including grid records, consist of a block of sequential data with an associated header array describing the data in the block. In a time-series record, the sequence represents the variation of a parameter's value through time at a fixed location. In a grid record, the sequence represents the variation of a parameter's value over a region of the earth's surface for a single interval of time. The header array of a grid record contains information about the parameter values (their units and some summary statistics) and the two-dimensional array in which they are stored (the number of rows and columns in the array, and the location of the grid in geo-referenced coordinates).

The contents of the header are described below for three types of grid records in DSS. The first grid header type is UNDEFINED and contains basic parameter and grid extent information, which is common to all grid types. The headers for HRAP grids and Albers equal-area grids (including SHG grids) contain additional descriptive information specific to those grid types.

### B.3 Storage of Grid Values

In the DSS file, grid parameter values are stored in a single array, starting with the value in the minimum-x, minimum-y (or lower left) cell in the two-dimensional array. The values proceed by row in increasing column numbers and increasing row numbers, as illustrated in Figure B-1.
The array of parameter values is always compressed before it is written to a DSS file. Two compression methods are used. One is a run-length encoding method, which replaces repeated zero and null values with the number of times zero or null was repeated. The second method is the deflate method, which is included in the zlib library described in RFC 1950. The deflate format itself is described in RFC 1951. The deflate format and zlib are included in Javasoft's Java Development Kit version 1.1 and higher.

### B.4 Grid Header Contents

**Table B-1  Grid Header Contents**

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Size (Num. of Integers)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info Flat Size</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Grid Type</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Grid Info Size</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Start Time</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>End Time</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Data Units</td>
<td>Text</td>
<td>3</td>
</tr>
<tr>
<td>Data Type</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Lower Left Cell X</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Lower Left Cell Y</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Number of Cells X</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Number of Cells Y</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Cell Size</td>
<td>Float</td>
<td>1</td>
</tr>
<tr>
<td>Compression Method</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Compressed Array Size</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Field</td>
<td>Type</td>
<td>Size (Num. of Integers)</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Compression Scale Factor</td>
<td>Float</td>
<td>1</td>
</tr>
<tr>
<td>Compression Base</td>
<td>Float</td>
<td>1</td>
</tr>
<tr>
<td>Max Data Value</td>
<td>Float</td>
<td>1</td>
</tr>
<tr>
<td>Min Data Value</td>
<td>Float</td>
<td>1</td>
</tr>
<tr>
<td>Mean Data Value</td>
<td>Float</td>
<td>1</td>
</tr>
<tr>
<td>Number of Ranges</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Range Limit Table</td>
<td>Float</td>
<td>20</td>
</tr>
<tr>
<td>Range Counts</td>
<td>Integer</td>
<td>20</td>
</tr>
</tbody>
</table>

Table B-2  Additional Grid Header Fields for HRAP Grids

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Size (Num. of Integers)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source</td>
<td>Text</td>
<td>3</td>
</tr>
</tbody>
</table>

Table B-3  Additional Grid Header Fields for SHG and Other Albers Grids

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Size (Num. of Integers)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projection Datum</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Projection Units</td>
<td>Text</td>
<td>3</td>
</tr>
<tr>
<td>First Standard Parallel</td>
<td>Float</td>
<td>1</td>
</tr>
<tr>
<td>Second Standard Parallel</td>
<td>Float</td>
<td>1</td>
</tr>
<tr>
<td>Central Meridian</td>
<td>Float</td>
<td>1</td>
</tr>
<tr>
<td>Latitude of Origin</td>
<td>Float</td>
<td>1</td>
</tr>
<tr>
<td>False Easting</td>
<td>Float</td>
<td>1</td>
</tr>
<tr>
<td>False Northing</td>
<td>Float</td>
<td>1</td>
</tr>
<tr>
<td>X Coordinate of Cell (0,0)</td>
<td>Float</td>
<td>1</td>
</tr>
<tr>
<td>Y Coordinate of Cell (0,0)</td>
<td>Float</td>
<td>1</td>
</tr>
</tbody>
</table>
Appendix C

HRAP Grid System

The Hydrologic Rainfall Analysis Project (HRAP) grid is a square-celled map grid based on a Polar Stereographic map projection with the following parameters.

- **Units:** Meters
- **Datum:** Sphere (radius = 6371.2 km)
- **Standard Parallel:** 60° 0’ 0” North
- **Central Meridian:** 105° 0’ 0” West

![HRAP Grid](image)

**Figure C-1 HRAP Grid**

The mesh (cell) size of the grid is 4.7625 km, and the Y axis of the grid is aligned parallel with the central meridian (105° W). The grid is registered so that the North Pole will be located exactly 400 cells in the positive X direction and 1600 cells in the positive Y direction from the grid origin. Equivalently, the lower left corner of cell number (401, 1601) is located at the North Pole.

**C.1 Examples**

As examples of cell identification in the HRAP system, indices of cells containing points in the western US and the eastern US are given.

**Western United States:** The location 121° 45’ west, 38° 35’ north (near Davis, California) projects to 260174 m easting, 2143782 m northing, in the specified polar stereographic projection. In the HRAP system the indices of the cell containing this point are:
i = 54
j = 450

**Eastern United States:** The location 76° 30′ west, 42° 25′ north (near Ithaca, New York) projects to 4410804 m easting, 3018420 m northing, in the specified polar stereographic projection. In the HRAP system the indices of the cell containing this point are:

i = 926
j = 633
Appendix D

SHG Grid System

The standard hydrologic grid (SHG) is a variable-resolution square-celled map grid defined for the conterminous United States. The coordinate system of the grid is based on the Albers equal-area conic map projection with the following parameters.

Units: Meters
Datum: North American Datum, 1983 (NAD83)
1st Standard Parallel: 29º 30’ 0” North
2nd Standard Parallel: 45º 30’ 0” North
Central Meridian: 96º 0’ 0” West
Latitude of Origin: 23º 0’ 0” North
False Easting: 0.0
False Northing: 0.0

Users of the grid can select a resolution suitable for the scale and scope of the study for which it is being used. HEC supports the following grid resolutions: 10,000 m, 5,000 m, 2,000 m, 1,000 m, 500 m, 200 m, 100 m, 50 m, 20 m, and 10 m. The grids resulting from the different resolutions will be referred to as SHG two-kilometer, SHG one-kilometer, SHG 500-meter, and so on. For general-purpose hydrologic modeling with NEXRAD radar precipitation data, HEC recommends 2,000 m cells, and HEC computer programs that use the SHG for calculation will select this cell size as a default. A grid identified as SHG with no cell-size indication will be assumed to have two-kilometer cells.

For identification, each cell in the grid has a pair of integer indices (i, j) indicating the position, by cell count, of its southwest (or minimum-x, minimum-y) corner, relative to the grid’s origin at 96º W, 23º N. For example the southwest corner of cell (121,346) in...
the SHG two-kilometer grid is located at an easting of 242,000 m and a northing of 692,000 m.

To find the indices of the cell in which a point is located, find the point’s easting and northing in the projected coordinate system defined above, and calculate the indices with the following formulas.

\[
\begin{align*}
i &= \text{floor} \left( \frac{\text{easting}}{\text{cellsize}} \right) \\
j &= \text{floor} \left( \frac{\text{northing}}{\text{cellsize}} \right)
\end{align*}
\]

where \(\text{floor}(x)\) is the largest integer less than or equal to \(x\).

## D.1 Examples

As examples of cell identification in the SHG system, indices of cells containing points in the western US and the eastern US will be given in the one-kilometer, two-kilometer, and 500-meter SHG grids.

**Western United States:** The location 121° 45′ west, 38° 35′ north (near Davis, California) projects to -2,185,019 m easting, 2,063,359 m northing, in the specified Albers projection. In the SHG two-kilometer system the indices of the cell containing this point are:

\[
\begin{align*}
i &= \text{floor} \left( \frac{-2185019}{2000} \right) = \text{floor}( -1092.5 ) = -1093 \\
j &= \text{floor} \left( \frac{2063359}{2000} \right) = \text{floor}( 1031.7 ) = 1031
\end{align*}
\]

**Eastern United States:** The location 76° 30′ west, 42° 25′ north (near Ithaca, New York) projects to 1,583,506 m easting, 2,320,477 m northing, in the specified Albers projection. In the SHG two-kilometer system the indices of the cell containing this point are:

\[
\begin{align*}
i &= \text{floor} \left( \frac{1583509}{2000} \right) = \text{floor}( 791.8 ) = 791 \\
j &= \text{floor} \left( \frac{2320477}{2000} \right) = \text{floor}( 1160.2 ) = 1160
\end{align*}
\]

In the SHG one-kilometer grid the indices are (1583, 2320), and in SHG 500-meter the indices are (3167, 4640).
Appendix E

Setting Up the Coordinate System

To maintain a geographic reference (also called a geo-reference), HEC-GridUtil uses a user-selected coordinate system, called the World Coordinate System (WCS). This superimposes a grid on layer features to establish x- and y-coordinates in WCS for each point on the layer. The x-coordinate is referred to as "easting" and the y-coordinate is referred to as "northing" following customary use in surveying and mapping. You can select the extent of this grid, the dimensions of the cells of the grid, the units of measurement of the grid, and even the location of the origin of the grid. This appendix focuses on how to setup and edit different coordinate systems.

It should be emphasized that GridUtil only applies transforms to gridded SHG or HRAP data. GridUtil does not apply coordinate transformations to plot other types of map data, including raster, vector, and point data. Therefore, coordinate transformations should be performed external to the program using a GIS software. Once the data is loaded to GridUtil, the user should specify its coordinate system. How this is accomplished is the focus of this chapter.

E.1 Geographic Referencing

To maintain a geographic reference, you must specify a coordinate system for each watershed. To establish the grid size and coordinate system:

From the View menu, select Layers… The Layer Selector will open. From the Maps menu of the Layer Selector, select Map Display Coordinates… The Display Coordinate Information dialog box will open (Figure E-1).

![Display Coordinate Information Dialog Box](image)

Figure E-1  Display Coordinate Information Dialog Box
The information in the Display Coordinate Information dialog box includes:

- **Coordinate System.** This box identifies the established coordinate system for a study. To edit the coordinate system, click **Edit**, and the **Map Coordinate Information** dialog box (Figure E-2) will open. Remember that all layers must exist in one unified coordinate system.

![Map Coordinate Information Dialog Box](image)

**Figure E-2  Map Coordinate Information Dialog Box**

- **Extents – Easting Minimum, Maximum, Northing Minimum, and Maximum.** These values indicate the location of the left, right, bottom and top borders (respectively) of the grid in the map window.

- **Grow to Map Extents.** When selected, GridUtil automatically sets the geographic extents to define the smallest rectangle that encompasses all the objects in the study.

- **Set Map Coordinates to Display.** This will set the limits of the map window. If you zoom in on an area, and click **Set Map Coordinates to Display**, the extents on the **Default Map Properties**, the **Display Coordinate Information** dialog box (Figure E-1) will change to the zoomed area.

Note that the geographic extents of your layers must be selected carefully to ensure that the entire study is included. Furthermore, the extents you specify and the coordinate system you use must be consistent for all the layers. Therefore, you may need to use GIS tools to transform the layers from one coordinate system to another before using them with GridUtil. GridUtil has no coordinate system transformation tools.

### E.2 Coordinate System Types

A **coordinate system** is a method of representing points in a space of given dimensions by coordinates. There are several different types of coordinate systems; two of interest to GridUtil is the geographic coordinate system, which is based on latitude and longitude coordinates, and the project coordinate system that represents the projection of a geographic coordinate system on a plane.

The coordinate systems available in GridUtil are shown in Table E-1. This table also shows the units and spheroid type for each coordinate system. A **spheroid** (ellipsoid) is the shape of the earth that is used in the
calculations that transform positions on the curved surface of the earth to positions on a flat map. It is part of the horizontal datum, which approximates the curved surface of the earth over part of the globe.

Table E-1  Coordinate Systems Available in GridUtil

<table>
<thead>
<tr>
<th>Coordinate Systems</th>
<th>Units</th>
<th>Spheroid</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-Y</td>
<td>U.S. feet</td>
<td>N/A</td>
</tr>
<tr>
<td>Geographic</td>
<td>radians</td>
<td>WGS 72</td>
</tr>
<tr>
<td>Universal Transverse Mercator</td>
<td>meters</td>
<td>GRS 1980 (NAD83)</td>
</tr>
<tr>
<td>State Plane Coordinates</td>
<td>meters</td>
<td>GRS 1980 (NAD83)</td>
</tr>
<tr>
<td>Albers Equal-Area Conic</td>
<td>Degrees of Arc</td>
<td>Sphere of Radius 6,370,997 m</td>
</tr>
<tr>
<td>Lambert Conformal Conic</td>
<td>International Feet</td>
<td></td>
</tr>
<tr>
<td>Transverse Mercator</td>
<td>U.S. feet</td>
<td>Clarke 1866 (NAD27)</td>
</tr>
<tr>
<td>Albers Equal-Area Conic (SHG)</td>
<td>meters</td>
<td>GRS 1980 (NAD83)</td>
</tr>
<tr>
<td>Polar Stereographic (HRAP)</td>
<td>meters</td>
<td>Sphere of Radius 6,371,200 m</td>
</tr>
</tbody>
</table>

E.2.1 X-Y Coordinate System

The X-Y coordinate system is also known as the World Coordinate System (WCS). This superimposes a grid on layer features to establish x- and y-coordinates for each point on the layer. The origin point (0,0) can be located anywhere, but every object is located in relation to the origin point. For the X-Y coordinate system there is not a specification for spheroid.

To set parameters for the X-Y Coordinate System:

1. Starting in the Layer Selector, from the Maps menu, select Map Display Coordinates. The Display Coordinate Information dialog box will open (see Figure D–1, page D-1).

2. The Coordinate System box contains the default coordinate system for the maps. Click Edit, and the Map Coordinate Information dialog box (Figure E-2) will open.

3. From the System list, select X-Y.

4. From the Units list, select the units for the X-Y coordinate system.
5. Click OK. The Map Coordinate Information dialog box will close, and you will be returned to the Display Coordinate Information dialog box. In the Coordinate System box, X-Y should be displayed.

### E.2.2 Geographic Coordinate System

For the geographic coordinate system, you will specify units and a spheroid type. To set parameters for the Geographic Coordinate System:

1. Starting in the Layer Selector, from the Maps menu, select Map Display Coordinates. The Display Coordinate Information dialog box will open (see Figure E-1, page E-1).

2. The Coordinate System box contains the default coordinate system for the maps. Click Edit, and the Map Coordinate Information dialog box (Figure E-3) will open.

![Map Coordinate Information dialog box](Figure E-3 Geographic Coordinate System)

3. From the System list, select Geographic.

4. From the Units list, select the units for the Geographic coordinate system. The only units available should be Radians, Seconds of Arc, and Degrees of Arc.

5. From the Spheroid list, select a spheroid type for the Geographic coordinate system.

6. Click OK. The Map Coordinate Information dialog box will close, and you will be returned to the Display Coordinate Information dialog box. In the Coordinate System box, Geographic should be displayed.

### E.2.3 Universal Transverse Mercator Coordinate System

The Universal Transverse Mercator (UTM) coordinate system is a projection coordinate system. UTM is used to define horizontal positions throughout the world by dividing the surface of the Earth into six-degree zones, with a central meridian in the center of each zone.
To set parameters for the Universal Transverse Mercator Coordinate System:

1. Starting in the Layer Selector, from the Maps menu, select Map Display Coordinates. The Display Coordinate Information dialog box will open (see Figure E-1, page E-1).

2. The Coordinate System box contains the default coordinate system for the maps. Click Edit, and the Map Coordinate Information dialog box (Figure E-4) will open.

3. From the System list, select Universal Transverse Mercator.

4. From the Units list, select the units for the Universal Transverse Mercator coordinate system.

5. From the Spheroid list, select a spheroid type for the Universal Transverse Mercator coordinate system.

6. In the UTM Zone box, enter the UTM zone number.

7. Click OK. The Map Coordinate Information dialog box will close, and you will be returned to the Display Coordinate Information dialog box. In the Coordinate System box, Universal Transverse Mercator should be displayed.

**E.2.4 State Plane Coordinate System**

The State Plane Coordinate System (SPCS) was established in the 1930s and now covers all fifty states. Zones were established for each state using either the Lambert Conformal or Traverse Mercator projections. Units are generally in feet (NAD27) or meters (NAD83).
To set parameters for the State Plane Coordinate System:

1. Starting in the **Layer Selector**, from the **Maps** menu, select **Map Display Coordinates**. The **Display Coordinate Information** dialog box will open (see Figure E-1, page E-1).

2. The **Coordinate System** box contains the default coordinate system for the maps. Click **Edit**, and the **Map Coordinate Information** dialog box (Figure E-5) will open.

3. From the **System** list, select State Plane Coordinates.

4. From the **Units** list, select the units for the State Plane coordinate system.

5. From the **Spheroid** list, select a spheroid type for the State Plane coordinate system. There should only be two choices: **Clarke 1866(NAD27)** and **GRS 1980(NAD83)**.

6. In the **Zone** box, enter the zone for the state. These codes are FIPS codes.

7. Click **OK**. The **Map Coordinate Information** dialog box will close, and you will be returned to the **Display Coordinate Information** dialog box. In the **Coordinate System** box, **State Plane Coordinates** should be displayed.

### E.2.5 Albers Equal-Area Conic Coordinate System

The Albers Equal-Area Conic projection was established for mapping large countries like the United States. The projection is an equivalent projection, where areas are proportional and directions are true in limited areas.

To set parameters for the Albers Equal-Area Conic Coordinate System:

1. Starting in the **Layer Selector**, from the **Maps** menu, select **Map Display Coordinates**. The **Display Coordinate Information** dialog box will open (see Figure E-1, page E-1).
2. The Coordinate System box contains the default coordinate system for the maps. Click Edit, and the Map Coordinate Information dialog box (Figure E-6) will open.

![Figure E-6 Albers Equal-Area Conic Coordinate System](image)

3. From the System list, select Albers Equal-Area Conic.

4. From the Units list, select the units for the Albers Equal-Area Conic coordinate system.

5. From the Spheroid list, select a spheroid type for the Albers Equal-Area Conic coordinate system.

6. The remaining items to be entered are the angular parameters that are required to fine-tune the projection. When specifying latitudes you will enter N or S, and for longitudes, you will enter E or W. Use the SPACEBAR to toggle between the entries.

7. Click OK. The Map Coordinate Information dialog box will close, and you will be returned to the Display Coordinate Information dialog box. In the Coordinate System box, Albers Equal-Area Conic should be displayed.

### E.2.6 Lambert Conformal Conic Coordinate System

The Lambert Conformal Conic projection is used extensively for mapping areas of the world with predominantly east-west orientation. It is similar to the Albers Equal-Conic projection; however the projection is not done in an equal-area.

To set parameters for the Lambert Conformal Conic Coordinate System:

1. Starting in the Layer Selector, from the Maps menu, select Map Display Coordinates. The Display Coordinate Information dialog box will open (see Figure E-1, page E-1).
2. The **Coordinate System** box contains the default coordinate system for the maps. Click **Edit**, and the **Map Coordinate Information** dialog box (Figure E-7) will open.

![Figure E-7 Lambert Conformal Conic Coordinate System](image)

3. From the **System** list, select Lambert Conformal Conic.

4. From the **Units** list, select the units for the Lambert Conformal Conic coordinate system.

5. From the **Spheroid** list, select a spheroid type for the Lambert Conformal Conic coordinate system.

6. When specifying latitudes you will enter **N** or **S**, and for longitudes, you will enter **E** or **W**. Use the **Spacebar** on the keyboard to toggle between the entries.

7. Click **OK**. The **Map Coordinate Information** dialog box will close, and you will be returned to the **Display Coordinate Information** dialog box. In the **Coordinate System** box, **Lambert Conformal Conic** should be displayed.

### E.2.7 Transverse Mercator Coordinate System

The Transverse Mercator projection is where a sphere is projected onto a cylinder tangent to a central meridian. It is similar to the Lambert Conformal Conic project, but used to portray large areas in a north-south orientation. Many national grid systems are based on the Transverse Mercator projection.

To set parameters for the Transverse Mercator Coordinate System:

1. Starting in the **Layer Selector**, from the **Maps** menu, select **Map Display Coordinates**. The **Display Coordinate Information** dialog box will open (see Figure E-1, page E-1).
2. The **Coordinate System** box contains the default coordinate system for the maps. Click **Edit**, and the **Map Coordinate Information** dialog box (Figure E-8) will open.

![Map Coordinate Information dialog box](image)

**Figure E-8** Transverse Mercator Coordinate System

3. From the **System** list, select Transverse Mercator.

4. From the **Units** list, select the units for the Transverse Mercator coordinate system.

5. From the **Spheroid** list, select a spheroid type for the Transverse Mercator coordinate system.

6. Enter a scaling factor for central meridian, in the **Scale factor at central meridian** box.

7. When specifying latitudes you will enter N or S, and for longitudes, you will enter E or W. Use the **SPACEBAR** to toggle between the entries.

8. Click **OK**. The **Map Coordinate Information** dialog box will close, and you will be returned to the **Display Coordinate Information** dialog box. In the **Coordinate System** box, Transverse Mercator should be displayed.

### E.2.8 Albers Equal-Area Conic (SHG) Coordinate System

This is the SHG version of the Albers Equal-Area Conic coordinate system. The parameters are set to match USACE map coordinates for SHG, so do not change any parameter settings.
To view the parameters for the Albers Equal-Area Conic (SHG) Coordinate System:

1. Starting in the *Layer Selector*, from the *Maps* menu, select *Map Display Coordinates*. The *Display Coordinate Information* dialog box will open (see Figure E-1, page E-1).

2. The *Coordinate System* box contains the default coordinate system for the maps. Click *Edit*, and the *Map Coordinate Information* dialog box (Figure E-9) will open.

3. From the System list, select Albers Equal-Area Conic (SHG).

4. From the *Units* list, select the units for the Albers Equal-Area Conic (SHG) coordinate system.

5. From the *Spheroid* list, select a spheroid type for the Albers Equal-Area Conic (SHG) coordinate system.

6. The remaining parameters are informational and are not editable.

7. Click *OK*. The *Map Coordinate Information* dialog box will close, and you will be returned to the *Display Coordinate Information* dialog box. In the *Coordinate System* box, *Albers Equal-Area Conic (SHG)* should be displayed.

### E.2.9 Polar Stereographic (HRAP) Coordinate System

The Polar Stereographic (HRAP) is used for navigation in polar regions. The parameters are set to match NWS map coordinates used for radar grids, so do not change any parameter settings.
To view the parameters for the Polar Stereographic (HRAP) Coordinate System:

1. Starting in the Layer Selector, from the Maps menu, select Map Display Coordinates. The Display Coordinate Information dialog box will open (see Figure E-1, page E-1).

2. The Coordinate System box contains the default coordinate system for the maps. Click Edit, and the Map Coordinate Information dialog box (Figure E-10) will open.

![Map Coordinate Information](image)

**Figure E-10  Polar Stereographic (HRAP) Coordinate System**

3. From the System list, select Polar Stereographic (HRAP).

4. From the Units list, select the units for the Polar Stereographic (HRAP) coordinate system.

5. From the Spheroid list, select a spheroid type for the Polar Stereographic (HRAP) coordinate system.

6. From the Axis box you can edit the axes information for either the Semi-major or the Semi-minor axes.

7. The remaining parameters are informational and are not editable.

8. Click OK. The Map Coordinate Information dialog box will close, and you will be returned to the Display Coordinate Information dialog box. In the Coordinate System box, Polar Stereographic (HRAP) should be displayed.
Appendix F

Using Map Editors

There are seven map layers supported by HEC-GridUtil. The different map layers are described in Chapter 5 of this manual. In GridUtil you can configure several options for each type of map layer, except for AutoCAD® DXF files; additional customization is in development for future versions of the software.

You will access the map layer editors from the Layer Selector, which provides a view of the active map layers in the Map Panel. Before attempting to edit the layers, select Allow Layer Editing in the Edit menu. In the Layer Selector, right-click on a map layer name, and from the shortcut menu, click Properties. An editor specific to the type of map layer you selected will open. The functions of each editor will be covered in the following sections.

F.1 Arc Shapefiles (.shp)

This layer type is the native data structure for the ArcView® GIS program. Shapefiles store non-topological geometry and attribute information for the spatial features of a data set. There are three kinds of shapefiles: line, polygon, and point.

To edit a line shapefile:

1. In the Layer Selector, right-click on a line shapefile and from the shortcut menu click Properties.

2. The Edit Line Properties dialog box (Figure F-1) will open.

3. Across the top of the dialog box is displayed the location and name of the shapefile.

4. Two tabs exist within the Edit Line Properties dialog box: Style and Labels. The Style tab allows for adjustment of the features of the line, while the Labels tab allows for inclusion of labels to identify the lines within the shapefile.

![Figure F-1 Edit Line Properties Dialog Box with One Style selected](image)
5. To edit the line style, two options exist. The first allows for features to be drawn using only one style (Figure F-1). Editing the line using only one feature allows the user to set just one color, style, and weight applied evenly throughout the line. The second allows for features to be drawn using attribute values (Figure F-2). Each shapefile has a set of attributes assigned to it from GIS. GridUtil allows for the user to edit the features of each of the attributes of the shapefile. If the latter option is chosen, and features are edited according to attribute, click on **Attribute Values** under the **Draw Features using** dropdown menu within the **Style** tab of the **Edit Line Properties** dialog box. Click on the attribute you would like to edit from the dropdown menu **Field for values**.

6. For example, if the layer in question contains streams, the user may want to edit the shapefile according to the length of each stream. First, find the attribute **Length** within the dropdown menu **Field for values**. Next, adjust the style and weight of the line. Finally, if it is desired to color-code the streams according to length, click on the box **Use Gradations** to specify the number of gradations. This will create color-code bins based on length, and will assign a different color to each stream depending on the interval of length the stream falls. (See Figure F-3).

7. If the user would like to view labels associated with a given feature of the line, the **Labels** tab should be invoked from the **Edit Line Properties** dialog box. In the example provided in item 6, in which the line is adjusted based on length, labels corresponding to lengths are attached to each stream segment. Figure F-4 shows the **Labels** tab within the **Edit Line Properties** dialog box, and corresponding labels attached to each stream segment. “**Length**” is selected from the dropdown menu **Label Features using**, and the text font, size and placement can be adjusted here as well.

8. On the **Edit Line Properties** dialog box, click **OK**, and the dialog box will close. From the **Layer Selector** dialog box, click **Apply**, and the labels for the selected field and any other changes will appear in the display area.
Figure F-3  Editing a stream layer according to stream lengths

Figure F-4  Inclusion of labels indicating stream lengths
To edit a polygon shapefile:

1. From the **Layer Selector** dialog box, right-click on the polygon shapefile and click on **Properties**.

2. The **Edit Polygon Properties** dialog box (Figure F-5) will open.

3. Across the top of the dialog box is displayed the location and name of the shapefile.

4. Three tabs can be selected within the **Edit Polygon Properties** dialog box. The first allows for editing the shapefile’s fill. The second allows for editing the shapefile’s border. The third allows for editing any labels associated with the shapefile.

5. A polygon shapefile’s fill can be edited by applying one fill evenly to all the polygons. From within the **Fill** tab (Figure F-5), click on **One Fill** from the **Draw Features using** dropdown menu. Here, the option to adjust the color, style and transparency of the fill is provided. Check the **Display Fill** box to display the fill. Click **Apply** in the **Edit Polygon Properties** dialog box and **Apply** in the **Layer Selector** dialog box to see the changes implemented.

6. A polygon shapefile’s fill can also be edited according to an attribute of the shapefile (Figure F-6). To do so, click on **Attribute Values** from the **Draw Features using** dropdown menu. Click on the **Display Fill** checkbox to be able to view the fill. From the **Field for values** dropdown menu, click on the desired attribute by which to edit the fill. The style, gradations, transparency, and color of the fill can then be edited. Figure F-7 shows an example of the polygon.
fill edited according to elevation. As shown in the figure, gradations can be used to color-code the polygons according to which elevation bins (intervals) they fall into.

7. A polygon shapefile’s border can be edited (Figure F-8). Within the Edit Polygon Properties dialog box, click on the Border tab. Click on the Display Border checkbox to be able to display the changes made to the shapefile’s borders. Then, adjust the color, style and weight of the borders. Click Apply in the Edit Polygon Properties dialog box and Apply in the Layer Selector dialog box to see the changes implemented.

A polygon shapefile’s labels can also be edited (Figure F-8). Within the Edit Polygon Properties dialog box, click on the Labels tab. Figure F-8 shows an example of labels attached to each polygon based on elevation. This was achieved by finding Elevation within the dropdown menu of Label features using. Thereafter, the font type, size, and placement can be modified. Click Apply in the Edit Polygon Properties dialog box and Apply in the Layer Selector dialog box to see the changes implemented.
To edit a point shapefile:

1. From the **Layer Selector**, right-click on a point shapefile and from the shortcut menu click **Properties**.

2. The **Edit Point Properties** dialog box (Figure F-9) will open.

3. Across the top of the dialog box is displayed the location and name of the shapefile.

4. Two tabs exist within the **Edit Point Properties** dialog box: Style and Labels. The Style tab allows for adjustment of the features of the point, while the Labels tab allows for inclusion of labels to identify the lines within the shapefile.

5. To edit the point style, two options exist. The first allows for features to be drawn using only one style (Figure F-9). Editing the point using only one feature allows the user to set just one color, style, and weight applied evenly throughout all points in the shapefile. The second allows for features to be drawn using attribute values (Figure F-10). Each shapefile has a set of attributes assigned to it from GIS. GridUtil allows for the user to edit the features of each of the attributes of the shapefile. If the latter option is chosen, and features are edited according to attribute, click on **Attribute Values** under the **Draw Features using** dropdown menu within the **Style** tab of the **Edit Point Properties** dialog box. Click on the attribute you would like to edit from the dropdown menu **Field for values**. The example of Figure F-10 shows a rain gage edited according to agency.
6. If the user would like to view labels associated with a given feature of the points, the **Labels** tab should be invoked from the *Edit Point Properties* dialog box. Figure F-11 shows the **Labels** tab within the *Edit Point Properties* dialog box, and corresponding labels assigned to each point. “**Name**” is selected from the dropdown menu **Label Features using**, and the text font, size and placement can be adjusted here as well.

![Figure F-11 Labels assigned to point shapefile](image)

7. On the *Edit Point Properties* dialog box, click **OK**, and the dialog box will close. From the *Layer Selector* dialog box, click **Apply**, and the labels for the selected field and any other changes will appear in the display area.

### F.2 USGS Digital Line Graph (.dlg)

This layer type is a vector representation of the data. When GridUtil interacts with a *dlg* file it automatically creates a *dlgbin* file for use.

To edit a USGS Digital Line Graph file:

1. From the *Layer Selector*, right-click on a USGS Digital Line Graph file and from the shortcut menu, click **Properties**.

2. The **USGS Digital Line Graph Editor** (Figure F-12) will open.
3. Across the top of the dialog box, is displayed the location and name of the USGS Digital Line Graph file.

4. To change the color of the lines of the *dlg* file, click the color box. The *Color Chooser* will open.

5. The properties of the *Color Chooser* are discussed in detail in Appendix G. From the color palette, select a color, click *OK*. The *Color Chooser* will close and the selected color will now appear in the color box.

6. From the *Layer Selector* dialog box, click *Apply*, the color for the lines will appear in the display area.

7. You can control the appearance of nodes, line, and areas by selecting and clearing *Draw Nodes*, *Draw Lines*, and *Draw Areas*, respectively.

8. You can also control the saturation and brightness level of the color you have selected by entering values in the *Saturation* or *Brightness* boxes. Values entered for saturation or brightness must be between zero (0) and one (1).

9. When finished editing DLG display options, press *Apply* to see your changes in the *Map Panel* and continue editing or *OK* to save changes and close the dialog box.

### F.3 Elevation Options Dialog Box

The USGS DEM, ASCII NetTIN, and ArcInfo® DEM map layer formats all have the same editor – the *Elevation Options* dialog box.

To edit an ASCII NetTIN file:
1. From the **Layer Selector**, right-click on an ASCII NetTIN file. From the shortcut menu, click **Properties**.

2. The **Grid Display Options** dialog box (Figure F-13) will open.

3. Across the top of the dialog box is displayed the name of the ASCII NetTIN file.

4. From the list box, there are available color contour schemes – **Aspect Shading**, **Grayscale**, **Linear**, **Precipitation**, **Red-Green-Blue**, and **Terrain** (default).

5. The **Draw Edges** check box is specifically for ASCII NetTIN files. If selected, the edges of the triangles that make up an ASCII NetTIN file will be drawn.

6. You can set the contour tic interval by entering a value in the **Tic Interval** box. The program sets the maximum and minimum limits of the contours automatically. You can set your own maximum and minimum limits. Clear the **System Specified Min/Max Values** checkbox and the **Maximum** and **Minimum** boxes will become available for you to enter values.

7. You can control the **Brightness** (amount of white), **Saturation** (amount of black), and **Transparency** (level of opacity or alpha) for the colors by using the slider bars or boxes.

8. By default the **Aspect Shading** option is on. Aspect shading makes the map layer appear in relief by placing an imaginary light source above the map and shading the contours. You can adjust the angle of the light source by using the **Angle** slider bar or the box. If you do not want aspect shading, clear the **Aspect Shading** checkbox.

9. Clipping provides you a way to highlight an area based on your color choices and values. For maximum clipping, you would fill the contour with the clip color from the maximum value of the map to the value entered for **Maximum Clipping**. For example, you could use maximum clipping to show smog levels, cloud cover, or snow level at a particular elevation. By default, maximum clipping is turned off; to select, click the **Maximum Clipping** check box. Then choose a color by clicking the **Color** box and either enter a maximum clipping value by using the slider bar or enter a value in the box.
10. Minimum clipping will fill the contour with the clip color from the minimum value of the map to the value entered for **Minimum Clipping**. For example, you could use minimum clipping to see where a water level would be if it flooded to a particular elevation. By default, minimum clipping is turned off; to select, click the **Minimum Clipping** check box. Then choose a color by clicking the **Color** box and either enter a minimum clipping value by using the slider bar or enter a value in the box.

11. When finished editing grid display options, press **Apply** to see your changes in the **Map Panel** and continue editing or **OK** to save changes and close the dialog box.
Appendix G

Using the Color Chooser

The Color Chooser (Figure G-1) affords great flexibility when you need to select default colors for map layers, labels, and background colors in your watershed display. The Color Chooser has three tabs: Swatches, HSB, and RGB, offering three methods for choosing a color. For each method, the preview area allows you to see your choice before applying changes.

![Color Chooser](image)

**Figure G-1  Color Chooser – Swatches tab**

G.1 Swatches Tab

The Swatches worksheet provides a palette of pre-defined colors. From the palette, select a color. Once you have selected a color, the Recent box displays that color, as also does the Preview box. Click OK, the Color Chooser will close. Depending on where you accessed the Color Chooser, you will have to click either Apply or OK for the color change to appear in the map window.

For example, for a USGS Digital Line Graph, you would have accessed the Color Chooser from the USGS Digital Line Graph Editor. Once you have selected the color from the Color Chooser and closed, then you need to click OK or Apply from the USGS Digital Line Graph Editor for the color change to appear in the map window.
### G.2 HSB Tab

**HSB** is the Hue, Saturation, and Brightness color model, which allows you to set the hue, saturation, and brightness of the colors you wish to produce. From the *Color Chooser*, select the **HSB** tab; the **HSB** tab (Figure G-2) becomes available.

There are several ways to adjust the hue, saturation, and brightness of the colors. The slider bar in conjunction with the **H**, **S**, and **B** options will change the color, if you select *red* with the **H** option selected, then when you switch to the **S** and **B** options, you will be changing the saturation and brightness of *red*. Another way to affect the colors is in the **H**, **S**, and **B** boxes you can directly enter a value for hue, saturation, and brightness. The following rules apply to the values you can enter for each box, as shown in Table G-1.

#### Table G-1  HSB Rules

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>H</strong> = Hue</td>
<td>Measured in a circle from 0 – 359 degrees. 0 = red, 60 = yellow, 120 = green, 180 = cyan, 240 = blue, 300 = magenta</td>
</tr>
<tr>
<td><strong>S</strong> = Saturation</td>
<td>Amount of black, measured from 0 – 100%</td>
</tr>
<tr>
<td><strong>B</strong> = Brightness</td>
<td>Amount of white, measured from 0 – 100%</td>
</tr>
</tbody>
</table>
From the color palette, users can also click and drag the white circle to set a color. This will automatically change the hue, saturation, and brightness values, along with the red, green and blue color values. The red, green, and blue values in the R, G, and B boxes are informational and cannot be edited.

Click OK, the Color Chooser will close. Depending on where you accessed the Color Chooser, you will have to click either Apply or OK for the color change to appear in the display area.

G.3 RGB Tab

RGB is the Red, Green, and Blue color model, which allows you to set the red, green, and blue values of the colors you wish to produce. From the Color Chooser, select the RGB tab; the RBB tab (Figure G-3) becomes available.

![Color Chooser](image)

Figure G-3  Color Chooser – RGB tab

There are two ways to adjust the red, green, and blue value of colors. There is a slider bar for Red, Green, and Blue. As you change the slider bar for each one, in the Preview box, the color you are producing is shown. Another way to affect colors is in the Red, Green, and Blue boxes you can directly enter a value. There is also a slider bar to adjust the transparency of the color scale. Click OK, the Color Chooser will close. Depending on where you accessed the Color Chooser, you will have to click either Apply or OK for the color change to appear in the map window.
Appendix H

Importing Gridded Data into DSS

Grids are distributed in many file formats. HEC has built importers for a handful of these formats. The standard CWMS installation includes ascii2dssGrid, gridLoadXMRG, gridLoadNetCDF, which load ASCII, XMRG, and NetCDF files, respectively, into DSS format. An additional utility, grib2xmrg, converts NWS GRIB-formatted products to XMRG format. The XMRG files can then be imported into DSS using gridLoadXMRG. DSS currently only supports grids in the HRAP and SHG grid-referencing systems. SHG is the preferred system for CWMS.

H.1 ascii2dssGrid

Gridded data created by ArcGIS must be imported into DSS to be used in CWMS. ArcGIS cannot save to DSS directly. The ascii2dssGrid utility bridges the gap between raster GIS and grids in DSS through the use of an intermediate ASCII text file.

The intermediate ASCII file is formatted for compatibility with the ArcInfo® ASCIIGRID command. The files consist of a six-line header followed by an array of values laid out like an image of the grid. The six header lines are shown below.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCOLS</td>
<td>Number of grid columns (integer)</td>
</tr>
<tr>
<td>NROWS</td>
<td>Number of grid rows (integer)</td>
</tr>
<tr>
<td>XLLCORNER</td>
<td>Lower-left X coordinate (real)</td>
</tr>
<tr>
<td>YLLCORNER</td>
<td>Lower-left Y coordinate (real)</td>
</tr>
<tr>
<td>CELLSIZE</td>
<td>Cell size (real). This is the width of a square cell.</td>
</tr>
<tr>
<td>NODATA_VALUE</td>
<td>Value to indicate a null cell, where a value is either</td>
</tr>
<tr>
<td></td>
<td>missing or has been removed.</td>
</tr>
<tr>
<td></td>
<td>Default: -9999</td>
</tr>
</tbody>
</table>
H.1.1 Program Use

This program is executed by entering its name at the Windows or UNIX command prompt. Input and output files and other parameters are specified after the program name.

The arguments can be given in any order. The DUNITS and DTYPE arguments are optional. The units of the imported grid default to “mm” if DUNITS is absent. If the PATH argument contains valid times in both the D and E parts, the data type of the imported grid will default to PER-CUM. If the E part (end time) is blank, the data type will default to INST-VAL. If the GRIDTYPE argument is absent, the grid type will be read from the A part of the path argument.

For example, the command:

```
asc2dssGrid in=grid.asc dss=mydss.dss
```

will treat the contents of the ASCII file “grid.asc” as though they were PER-CUM precipitation data reported in millimeters, and create an HRAP grid record with the given path in the given DSS file.

The program has some simple checks for data errors, such as missing files, unsupported data types, and unsupported cell sizes. It does not check for unsupported unit names or unreasonable data values.

The following command could be used to import an elevation grid for lapse computations:

```
asc2dssGrid in=elev.asc dss=mydss.dss DTYPE=INST-VAL DUNITS=METERS path=/SHG/ROGUE/ELEVATION///IMPORT/
```

H.1.2 Program Parameters

Following is a descriptive list of parameters and their default values. Parameters are not case-sensitive on either UNIX or Windows systems. However, on UNIX systems, the program name is case sensitive, and the case of the specified input and output filenames will be retained.

H.2 gridLoadXMRG

The gridLoadXMRG program is a standalone utility for loading NexRad data received from a National Weather Service (NWS) river forecast center in the XMRG data format. The XMRG product may be acquired from a NWS site by use of a web browser or FTP.
### Appendix H – Importing Gridded Data into DSS

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INPUT</td>
<td>Name of ASCII file to be imported.</td>
</tr>
<tr>
<td>DSSFILE</td>
<td>Name of the DSS output file into which the product will be loaded.</td>
</tr>
<tr>
<td>PATHNAME</td>
<td>DSS record path name (A/B/C/D/E/F)</td>
</tr>
<tr>
<td>GRIDTYPE</td>
<td>Grid type to write to the DSS file. Options are: SHG, HRAP, or ALL (both SHG and HRAP)</td>
</tr>
<tr>
<td>DTYPET</td>
<td>Data type (Optional. Default: PER-CUM)</td>
</tr>
<tr>
<td>DUNITS</td>
<td>Data units (Optional. Default: mm)</td>
</tr>
</tbody>
</table>

This utility can be triggered from a cron job or other event that results in the acquisition of an XMRG product. Alternatively, one or more XMRG files can be piped into gridLoadXMRG.

The product is loaded into the Hydrologic Engineering Center’s Data Storage System (HEC-DSS) grid format, which may be used for modeling, graphics, or other analysis purposes. Specifying the GRIDTYPE=SHG option triggers a conversion of the precipitation from the HRAP grid to the Standard Hydrologic Grid (SHG), which requires a conversion table.

If SHGTAB is specified on the command line, the program looks for the HRAP-to-SHG conversion table in that file. If not, it looks for a file called “hraptab.dss” in the directory named in the environment variable HECSUP or in /usr/hec/sup, if HECSUP is not set. If no such file exists the program will also look for hraptab.dss in the local directory. If “hraptab.dss” does not exist in those locations, or if it exists but does not contain a record with the path name /HRAP2SHG/site///// the program will generate a conversion table record in hraptab.dss in the local directory. Use DSSUTL to copy this record to another file, if desired.

### H.2.1 Program Use

This program is executed by entering its name at the Windows or UNIX command prompt. If no input file is supplied, the program responds by asking for the name of the XMRG input file. Input and output files and other parameters are specified after the program name.

```plaintext
gridLoadXMRG xmrg=example.xmrg dss=example.dss

gridLoadXMRG xmrg=example.xmrg grid=hrap site=Example dss=example.dss
```
In UNIX, one or more XMRG files can be piped into the gridLoadXMRG program.

```
cat *.xmrg | gridLoadXMRG
```

```
cat *.xmrg | gridLoadXMRG xmr=example.xmrg dss=example.dss
```

This program must reside in a directory that is set in your path (e.g., \HEC\EXE), or reside in your current directory.

## H.2.2 Program Parameters

Following is a descriptive list of parameters and their default values. Parameters are not case-sensitive on either UNIX or Windows systems. However, on UNIX systems, the program name is case sensitive, and the case of the specified input and output filenames will be retained.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>XMRG</strong></td>
<td>Name of XMRG file to be loaded. If no input file is specified, the program will use piped input (for example, &quot;cat example.xmrg</td>
</tr>
<tr>
<td><strong>DSS</strong></td>
<td>Name of the DSS output file into which the product will be loaded. This will be ignored if CWMSDIR is specified (see below). Default Value: “xmrg.dss”</td>
</tr>
<tr>
<td><strong>GRIDTYPE</strong></td>
<td>Grid type to write to the DSS file. Options are: SHG, HRAP, or ALL (both SHG and HRAP)</td>
</tr>
<tr>
<td><strong>SITE</strong></td>
<td>Name of NexRad site (5 Char NWS designation). If BPART is specified and SITE is not, SITE will be set to the value specified for the BPART parameter. Default Value: “”</td>
</tr>
<tr>
<td><strong>BPART</strong></td>
<td>B part of the DSS input path. If SITE is specified and BPART is not, BPART will be set to the value specified for the SITE parameter. Default Value: “”</td>
</tr>
<tr>
<td><strong>FPART</strong></td>
<td>F part of the DSS input path – data version (optional). Default Value: “”</td>
</tr>
<tr>
<td><strong>CWMSDIR</strong></td>
<td>CWMS output directory. If specified, DSS grids will be written to &lt;CWMSDIR&gt;/precip.YYYY.MM.dss. Otherwise, grids will be written to the filename specified by the DSS parameter (see above).</td>
</tr>
</tbody>
</table>
### H.2.3 Extracting Data

GridLoadXMRG allows you to extract a rectangular region from an XMRG file, which is loaded into DSS. The extraction information is placed in an ASCII (text) file. The “EXTRACT” parameter is used to tell GridLoadXMRG the name of the extraction file.

The EXTRACT file must contain all of the following information. Each line should contain the name of the parameter, followed by a colon, then a space, and then the required information.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SubGridName</td>
<td>Name of extracted grid. This corresponds to the B PART of the DSS path.</td>
</tr>
<tr>
<td>SubGridType</td>
<td>Grid type to write to the DSS file. Options are: SHG, HRAP, or ALL (both SHG and HRAP)</td>
</tr>
<tr>
<td>SubGridVersion</td>
<td>Version of the extracted file. This corresponds to the F part of the DSS path.</td>
</tr>
<tr>
<td>SubGridOrigin</td>
<td>Coordinates of the top-left corner of the extraction rectangle (X, Y).</td>
</tr>
<tr>
<td>SubGridExtents</td>
<td>Horizontal and vertical extents of extraction rectangle (width, height)</td>
</tr>
<tr>
<td>SubGridCellSize</td>
<td>Size of grid cell, in meters. Use one of the following:</td>
</tr>
<tr>
<td></td>
<td>SHG: 2000.0 m</td>
</tr>
<tr>
<td></td>
<td>HRAP: 4762.5 m</td>
</tr>
</tbody>
</table>

Example extraction file, “extraction.txt”:

```
SubGridName: MBRFC
SubGridType: HRAP
```
SubGridVersion: PRECIP-SUBGRID
SubGridOrigin: 400,400
SubGridExtents: 20,30
SubGridCellSize: 4762.5

Example command:

```
gridLoadXMRG.exe xmrg=xmrg_2009.08.19.114514 out=extract2009.dss
extract=extract.txt gridtype=HRAP site=MBRFC fpart=PRECIP
```

**H.3 gridLoadNetCDF**

The gridLoadXMRG program is a standalone utility for loading gridded data stored in the NetCDF format.

**H.3.1 Program Use**

This program is executed by entering its name at the Windows or UNIX command prompt. Input and output files and other parameters are specified after the program name.

```
gridLoadNetCDF netcdf=example.netcdf dss=example.dss
gridLoadNetCDF netcdf=example.netcdf grid=hrap site=Example
dss=example.dss
```

This program must reside in a directory that is set in your path (e.g., `\HECEXE`), or reside in your current directory.

**H.3.2 Program Parameters**

Following is a descriptive list of parameters and their default values. Parameters are not case-sensitive on either UNIX or Windows systems. However, on UNIX systems, the program name is case sensitive, and the case of the specified input and output filenames will be retained.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NetCDF</strong></td>
<td>Name of NetCDF file to be loaded. If no input file is specified, the program will use piped input (for example, &quot;cat example.netcdf</td>
</tr>
<tr>
<td><strong>DSS</strong></td>
<td>Name of the DSS output file into which the product will be loaded. This will be ignored if CWMSDIR is specified (see below).</td>
</tr>
<tr>
<td><strong>GRIDTYPE</strong></td>
<td>Grid type to write to the DSS file. Options are: SHG, HRAP, or ALL</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>(both SHG and HRAP)</td>
<td>(both SHG and HRAP)</td>
</tr>
<tr>
<td>SITE</td>
<td>Name of NexRad site (5 Char NWS designation). If BPART is specified and SITE is not, SITE will be set to the value specified for the BPART parameter. Default Value: “”</td>
</tr>
<tr>
<td>BPART</td>
<td>B part of the DSS input path. If SITE is specified and BPART is not, BPART will be set to the value specified for the SITE parameter. Default Value: “”</td>
</tr>
<tr>
<td>FPART</td>
<td>F part of the DSS input path – data version (optional). Default Value: “”</td>
</tr>
<tr>
<td>CWMSDIR</td>
<td>CWMS output directory. If specified, DSS grids will be written to &lt;CSMSDIR&gt;/precip.YYYY.MM.dss. Otherwise, grids will be written to filename specified by the DSS parameter (see above).</td>
</tr>
<tr>
<td>SHGTAB</td>
<td>Name of DSS file that contains the HRAP-to-SHG conversion table. Default Value: “hraptab.dss”</td>
</tr>
<tr>
<td>XHRAP</td>
<td>X-coordinate of the southwest corner of the HRAP grid.</td>
</tr>
<tr>
<td>YHRAP</td>
<td>Y-coordinate of the southwest corner of the HRAP grid.</td>
</tr>
<tr>
<td>JPG</td>
<td>Name of optional JPG image output file.</td>
</tr>
</tbody>
</table>

**H.4 grib2xmr**

The “grib2xmr” utility converts gridded data provided in GRIB format to XMRG format. The XMRG output file created by this utility may then be loaded into DSS using “gridLoadXMRG”.

**H.4.1 Program Use**

This program can be run on the UNIX or Windows command line by piping the contents of the GRIB file to “grib2xmr” using the UNIX “cat” utility.

The “cat” utility is not available by default on Windows, but it can be obtained as a part of the UnxUtils package of UNIX utilities, which have been ported to Windows. This package may be downloaded from:
http://unxutils.sourceforge.net

The XMRG-formatted data output from “grib2xmrg” may be redirected to a new file. For example:

```bash
cat example.grib | grib2xmrg > example.xmrg
```

The new XMRG file can then be imported into DSS using gridLoadXMRG:

```bash
gridLoadXMRG xmrg=example.xmrg dss=example.dss gridtype=hrap
```

The above steps can be combined into a single command:

```bash
cat example.grib | grib2xmrg | gridLoadXMRG dss=example.dss gridtype=hrap
```
Appendix I

Exporting Gridded Data from DSS

I.1 dss2asciiGrid

Gridded data in DSS can be exported to ASCII text files, which can be read by ArcGIS and other software. The ASCII file is formatted for compatibility with the ArcInfo® ASCIIGRID command. The files consist of a six-line header followed by an array of values laid out like an image of the grid. The six header lines are:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCOLS</td>
<td>Number of grid columns (integer)</td>
</tr>
<tr>
<td>NROWS</td>
<td>Number of grid rows (integer)</td>
</tr>
<tr>
<td>XLLCORNER</td>
<td>Lower-left X coordinate (real)</td>
</tr>
<tr>
<td>YLLCORNER</td>
<td>Lower-left Y coordinate (real)</td>
</tr>
<tr>
<td>CELLSIZE</td>
<td>Cell size (real). This is the width of a square cell.</td>
</tr>
<tr>
<td>NODATA_VALUE</td>
<td>Value to indicate a null cell, where a value is either missing or has been removed.</td>
</tr>
<tr>
<td></td>
<td>Default: -9999</td>
</tr>
</tbody>
</table>

I.1.1 Program Use

This program is executed by entering its name at the Windows or UNIX command prompt. Input and output files and other parameters are specified after the program name.

The arguments can be given in any order. The following command will write the contents of a DSS grid record to an ASCII text file:

```
dss2asciiGrid OUTPUT=precip_grid.asc dss=mydss.dss
PREC=2 path=/HRAP/TEST/PRECIP/07JUN2007:0100/
07JUN2007:0200/IMPORT/
```
The ASCII text file created by this utility may need additional modification before it can be imported to other GIS or surface analysis programs.

### I.1.2 Program Parameters

Following is a descriptive list of parameters and their default values. Parameters are not case-sensitive on either UNIX or Windows systems. However, on UNIX systems, the program name is case sensitive, and the case of the specified input and output filenames will be retained.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OUTPUT</td>
<td>Name of ASCII file for exported data.</td>
</tr>
<tr>
<td>DSS</td>
<td>Name of the DSS input file to be exported.</td>
</tr>
<tr>
<td>PATH</td>
<td>DSS record path name (A/B/C/D/E/F)</td>
</tr>
<tr>
<td>PRECISION</td>
<td>Number of decimal places to use for the exported data.</td>
</tr>
</tbody>
</table>
Appendix J

Terms and Conditions for Use

Terms and Conditions for use of HEC-GridUtil:

The United States Government, US Army Corps of Engineers, Hydrologic Engineering Center (“HEC”) grants to the user the rights to install HEC-GridUtil “the Software” (either from a disk copy obtained from HEC, a distributor or another user, or by downloading it from a network) and to use, copy, and/or distribute copies of the Software to other users, subject to the following Terms and Conditions of Use:

All copies of the Software received or reproduced by or for user pursuant to the authority of this Terms and Conditions of Use will be and remain the property of HEC.

User may reproduce and distribute the Software provided that the recipient agrees to the Terms and Conditions for Use noted herein.

HEC is solely responsible for the content of the Software. The Software may not be modified, abridged, decompiled, disassembled, unobfuscated, or reverse-engineered. The user is solely responsible for the content, interactions, and effects of any and all amendments, if present, whether they be extension modules, language resource bundles, scripts, or any other amendment.

No part of this Terms and Conditions for Use may be modified, deleted, or obliterated from the Software.

No part of the Software may be exported or re-exported in contravention of U.S. export laws or regulations.

Waiver of Warranty

THE UNITED STATES GOVERNMENT AND ITS AGENCIES, OFFICIALS, REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS PROVIDE HEC-GRIDUTIL “AS IS,” WITHOUT ANY WARRANTY OR CONDITION, EXPRESS, IMPLIED OR STATUTORY, AND SPECIFICALLY DISCLAIM ANY IMPLIED WARRANTIES OF TITLE, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT. Depending on state law, the foregoing disclaimer may not apply to you, and you may also have other legal rights that vary from state to state.

Limitation of Liability

IN NO EVENT SHALL THE UNITED STATES GOVERNMENT AND ITS AGENCIES, OFFICIALS, REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS, BE LIABLE FOR LOST PROFITS OR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR IN CONNECTION WITH USE OF HEC-GRIDUTIL REGARDLESS OF CAUSE, INCLUDING NEGLIGENCE.

THE UNITED STATES GOVERNMENT’S LIABILITY, AND THE LIABILITY OF ITS AGENCIES, OFFICIALS, REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS, TO YOU OR ANY THIRD PARTIES IN ANY CIRCUMSTANCE IS LIMITED TO THE REPLACEMENT OF CERTIFIED COPIES OF HEC-GRIDUTIL WITH IDENTIFIED ERRORS CORRECTED. Depending on state law, the above limitation or exclusion may not apply to you.

Indemnity

As a voluntary user of HEC-GridUtil you agree to indemnify and hold the United States Government, and its agencies, officials, representatives, and employees, including its contractors and suppliers, harmless from any claim or demand, including reasonable attorneys’ fees, made by any third party due to or arising out of your use of HEC-GridUtil or breach of this Agreement or your violation of any law or the rights of a third party.

Assent
By using this program you voluntarily accept these terms and conditions. If you do not agree to these terms and conditions, uninstall the program and return any program materials to HEC. If you downloaded the program and do not have disk media, please delete all copies, and cease using the program.